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C H A P T E R  1  

Introduction 

This chapter provides common information on the virtual machine technology that is used by 
Parallels Desktop and will familiarize you with the main characteristics of a virtual machine 
created by Parallels Desktop. 

In This Chapter 
Virtual Machine Technology Overview................................................................................ 5 
About Parallels Desktop........................................................................................................ 6 
Intel Virtualization Technology (VT-x) Support .................................................................. 6 
Inside a Virtual Machine....................................................................................................... 7 
Supported Guest Operating Systems..................................................................................... 8 
Opening Parallels Desktop Help ........................................................................................... 10 
 
 

Virtual Machine Technology 
Overview 

Virtual machine (VM) technology provides the following main features: 

 Enables multiple guest operating systems (OSes) and their applications to simultaneously 
run on a single computer. 

 Creates a number of virtual machines, each with a full set of standard virtual hardware. 
Operating systems and applications are isolated inside these virtual machines and share 
physical hardware resources. 

 Offers an opportunity to switch between operating systems without rebooting and to 
consolidate and virtualize a computing environment, resulting in reduced hardware costs, 
lower operating expenses, and increased productivity. 

Notes: 1. "Primary operating system" (primary OS) denotes the operating system that controls 
the I/O devices of the computer and that loads when the real computer is turned on. 

2. "Guest operating system" (guest OS) is an operating system that runs under virtual machine 
control. One primary OS and multiple guest OSes can be run at the same time on a single real 
computer. 
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About Parallels Desktop 
Parallels™ Desktop is the most powerful, easy-to-use, cost-effective desktop virtualization 
solution available today. It empowers any user, from experienced professional developers to 
sales executives and casual home users, with the ability to create completely networked, totally 
secure independent virtual machines on a single physical machine. 

Parallels Desktop is powered by a lightweight hypervisor, a thin layer of software that is 
between part of the host computer’s hardware and the primary operating system. The 
lightweight hypervisor controls some of the host computer's hardware resources, resulting in 
dramatically more stable, more secure, and higher-performing virtual machines.  

Parallels Desktop's sophisticated virtualization engine enables each virtual machine to operate 
identically to a stand-alone computer. Each virtual machine works with its own processor, 
RAM, floppy, CD and DVD drives, I/O devices, and hard disk – everything a physical computer 
contains. See Inside a Virtual Machine (on page 7) for the full list of Parallels virtual machine 
devices.

Intel virtualization technology (VT-x) is fully supported by Parallels Desktop. See Intel 
Virtualization Technology (VT-x) Support (page 6). 

Parallels Desktop has a set of special tools (utilities and drivers) that enhances the performance 
and functionality of your guest operating system (mouse synchronization tool, clipboard 
synchronization tool, etc.). See Parallels Tools Overview (page 49) for the full list of tools and 
their descriptions. 
 

Intel Virtualization Technology (VT-x) 
Support 

Intel Virtualization Technology (VT-x), which is incorporated in the newest Intel processors, 
provides enhancements implemented into processor architecture that are specially designed for 
platforms running multiple operating systems. VT-enabled processors facilitate more efficient 
virtual machine partitioning and more precise virtual processor simulation. An extended set of 
processor instructions performs on a hardware level tasks previously realized programmatically, 
thus reducing virtualization overhead and improving virtual machine performance, security and 
stability. To learn more about Virtualization Technology see the Intel site 
http://www.intel.com/technology/computing/vptech/.  

Intel Virtualization Technology is fully supported by Parallels Desktop. If Parallels Desktop 
detects a VT-enabled CPU, support is automatically turned on if it is not blocked in BIOS. VT-x 
support can be manually enabled or disabled through a virtual machine configuration setting 
available in the VM Flags (page 83) section of General Options. If you run a guest OS with VT-
x enabled, the Virtualization mode flag in the About Parallels Desktop screen shows Intel VT-
x. See the More Information (page 116) section of the About Parallels Desktop screen. 
 

 

http://www.intel.com/technology/computing/vptech/
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Inside a Virtual Machine 
As we mentioned earlier, virtual machines work just like a stand alone computer.  Each VM 
contains the follow hardware: 

 CPU Intel Pentium; 
 Generic motherboard compatible with Intel i815 chipset; 
 RAM up to 1500 MB; 
 VGA and SVGA with VESA 3.0 support; 
 1.44 MB floppy drive mapped to an image file; 
 Up to four IDE devices, that may be either virtual hard drives (from 20 MB up to 128 GB 

each, mapped to image file), or CD/DVD-ROM drives (mapped to physical drive or to 
image file), or both hard drives and CD/DVD-ROM drives; 

 Ethernet virtual network card compatible with RTL8029. Parallels Desktop for Mac 
supports bridging to wireless network adapters; 

 Up to four serial (COM) ports (mapped to a socket or to output file); 
 Up to three bi-directional parallel (LPT) ports (mapped to output file); 
 2-port USB 1.1 controller; 
 AC'97-compatible sound card. Sound recording is supported; 
 A standard PC keyboard; 
 A PS/2 wheel mouse. 
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Supported Guest Operating 
Systems 

The current version of Parallels Desktop officially supports the following guest operating 
systems: 

Microsoft Windows Guest Operating Systems: 
 Windows 2003 Standard Edition SP0 
 Windows 2003 Standard Edition SP1 
 Windows 2003 Enterprise Edition SP0 
 Windows 2003 Enterprise Edition SP1 
 Windows 2003 Web Edition SP0 
 Windows 2003 Web Edition SP1 
 Windows XP SP2 Professional 
 Windows XP SP2 Home 
 Windows XP SP1 Professional 
 Windows XP SP1 Home 
 Windows XP SP0 Professional 
 Windows XP SP0 Home 
 Windows 2000 Professional Edition SP4 
 Windows 2000 Server SP4 
 Windows 2000 Advanced Server SP4 
 Windows NT Workstation 4.0 SP6 
 Windows NT Server 4.0 SP6 
 Windows ME 
 Windows 98 
 Windows 95 
 Windows 3.11 
 Windows 3.1 

Linux Guest Operating Systems: 
 Red Hat Enterprise Linux WS4 
 Red Hat Enterprise Linux AS4 
 Red Hat Enterprise Linux WS3 
 Red Hat Enterprise Linux ES4 
 Red Hat Enterprise Linux ES3 
 Red Hat Linux 9 
 Red Hat Linux 8 
 Red Hat Linux 7.3 
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 Debian Linux 3.1 
 Fedora Core Linux 4 
 Fedora Core Linux 3 
 SUSE Linux 10 
 SUSE Linux 9.3 
 SUSE Linux 9.2 
 SUSE Linux 9.1 
 SUSE Linux 9.0 
 Mandriva Linux 10.1 
 Mandriva Linux 10 
 Mandriva Linux 9.2 

FreeBSD Guest Operating Systems: 
 FreeBSD 5.4 
 FreeBSD 5.3 
 FreeBSD 4.5 
 FreeBSD 4.1 

OS/2 and eComStation Guest Operating Systems: 
 OS/2 warp 4.5  
 OS/2 warp 4 
 OS/2 warp 3 
 eComStation 1.2 
 eComStation 1.1 

Sun Solaris Guest Operating Systems: 
 Solaris 10 
 Solaris 9 

MS-DOS Guest Operating Systems: 
 MS-DOS 6.22 
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Opening Parallels Desktop Help 
To open this guide, select Help->Contents in the Parallels Desktop menu. 

Context-Sensitive Help 

To access help topics that directly relate to the Parallels Desktop window you are currently 
working with, press F1 on your keyboard. 

Some windows, such as Configuration Editor and Preferences, contain Help buttons that open the 
appropriate topic 

PDF version 

A .pdf version of this guide is included with this Parallels Desktop distribution. You can find 
it in the Parallels-Desktop-XXXX-Mac.dmg file. 
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C H A P T E R  2  

Installing Parallels Desktop 

In this chapter you’ll learn how to install Parallels Desktop on your Mac. 

In This Chapter 
System Requirements............................................................................................................ 11 
Installing Parallels Desktop................................................................................................... 12 
Starting Parallels Desktop ..................................................................................................... 17 
Activating Parallels Desktop................................................................................................. 17 
Updating Parallels Desktop................................................................................................... 20 
Uninstalling Parallels Desktop.............................................................................................. 23 
 
 

System Requirements 
Note. Before installing the product, please make sure your computer meets the hardware and 
software requirements described in this section. 
 

Hardware Requirements 
In order to install and successfully run Parallels Desktop you should have: 

 An Intel-powered CoreDuo or CoreSolo Mac Mini, iMac, MacBook or MacBook Pro. 
 A minimum of 512MB of RAM. 1GB recommended. 
 30MB of available hard drive space for Parallels Desktop installation, plus sufficient space 

to allocate to virtual machines. 15GB of hard drive space is recommended. 
 

Software Requirements 
Parallels Desktop can be successfully installed if you are running Mac OS X 10.4.6 or higher as 
your operating system.  

To check your version of Mac OS X, go to the Apple menu in the menu bar, and click About 
This Mac.  
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Installing Parallels Desktop 
Now that we’re past the geek-speak, let’s install Parallels Desktop! 

To install Parallels Desktop: 

1 First, download the Parallels Desktop installation file from the Parallels site. 

 To download a trial version, visit the Parallels Download Center 
http://www.parallels.com/en/download. 

 To buy a full-scale version, visit the Parallels Buy Online page 
http://www.parallels.com/en/buyonline. 

Select the Parallels Mac package for downloading. 

2 When the download is completed, double-click the Parallels-Desktop-XXXX-
Mac.dmg file on your desktop to open Parallels Desktop window. In this Parallels Desktop 
window, double-click the Parallels-Desktop.pkg icon to start installing. 

3 In the Introduction screen click the Continue button. 

 

 

http://www.parallels.com/en/download
http://www.parallels.com/en/buyonline
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4 In the Software License Agreement screen use the scroll bar to read the entire agreement. We 
recommend printing the license agreement for your records using the Print button or save for 
future reading using the Save button. When you are ready, click the Continue button. 

 
In the pop-up dialog, click the Agree button to continue installing.  
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5 Next you'll see the Select a Destination screen. Specify where you'd like to install Parallels 
Desktop on your hard disk and click Continue. 
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6 If you are satisfied with the destination entered, click Install to start the Parallels Desktop 
installation. 

Note: Of course, you can return to the previous steps by clicking the Go Back button at any 
time. 
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7 Installation progress is shown in the Installing Parallels Desktop window. 

 
8 When Parallels Desktop is installed, the wizard displays its final screen. To complete the 

installation, click Close. Yes, it was that easy! 
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Starting Parallels Desktop 
To start Parallels Desktop: 

 In the Finder, open your Applications folder, and then double click on the orange Parallels 

icon  . 

To save yourself from having to burrow into Applications every time you want to run the 
program, consider dragging its icon onto your Dock. 
 

Activating Parallels Desktop 

Getting an Activation Key 

If you already have an activation key, skip this section and proceed to Activating Your Copy of 
Parallels Desktop below in this topic.  

To get an evaluation key: 

1 Click Help in the menu and select Activate Product. This opens the Activate Product screen. 

2 In the Activate Product screen, click the “obtain a free trial activation key” link in the License 
Information text to open the User Registration Form. 

 



 Installing Parallels Desktop 18 
 

3 In the User Registration Form, specify your e-mail address and your name. Entering the 
name of your company is optional. Specify if you want news from Parallels to be sent to you 
through e-mail.  We suggest allowing us to e-mail you in order for you to be informed of 
free software updates, new releases, and other Parallels-related news. 

 
4 Finally, click the Register button to send this information to the Parallels Team. You will 

then have a free trial activation key sent immediately to the e-mail address you provided. 

If you’d prefer, you may register online at the Parallels website as well.  Click the Register 
On Site button at any time to proceed to the online registration. You will receive a free trial 
activation key through e-mail after completing the online form. 

If your trial key has expired, or you’re ready to start using Parallels Desktop with no time or 
feature restrictions, you’ll need a permanent activation key.  Here’s how to get one: 

1 Click Help in the menu and select Activate Product. This opens the Activate Product screen. 

2 In the Activate Product screen, click the “purchase a permanent activation key” hyperlink in 
License Information text to open the Parallels Online Store and purchase a permanent 
activation key.  It’s just that simple.  

Activating Your Copy of Parallels Desktop 

To activate Parallels Desktop, follow these easy steps: 

1 Click Help in the Parallels Desktop menu and select Activate Product. 
2 In the Activate Product window, fill in the following fields: 

 In the Activation Key field type the key provided for you. When you fill in this field, the 
Activate button becomes active. 
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 Specify your name and name of your company in the User Name and Company Name 
fields. Both of these fields are optional. 

 

After entering your activation key, click the Activate button. If you have entered a valid 
activation key, the following confirmation message will be displayed: "Parallels 
Desktop has been activated successfully. Thank you!”  Now that your 
copy of Parallels Desktop is active, you can build, configure, and run virtual machines, 
congratulations!  
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Updating Parallels Desktop 
Parallels Desktop includes an updating feature that helps you keep your Parallels Desktop 
installation up-to-date. Update checks can be initiated either automatically or manually: 

 We recommend that you turn on automatic  update checking in order to be notified 
when an update is available. Parallels Desktop will regularly check the Parallels FTP server 
in the background and will inform you only when an update is available. 

 In addition to automatic checking, you may start the updater manually at any time.  

Automatic Checking for Updates 

System Requirements 

To use the automatic checking for updates feature, your Mac should have: 

 A stable Internet connection without firewall and/or antivirus software preventing Parallels 
Desktop from accessing the Internet. 

Configuring Parallels Desktop 

To configure Parallels Desktop: 

1 Select Help -> Check for Update in the menu. You will see the following screen: 

 
2 Select Check for update automatically.  

3 Specify the frequency in the Perform check every day(s) field. With these options set, 
Parallels Desktop will access the Parallels FTP server and notify you when an update is 
available. 
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4 If you want Parallels Desktop to automatically download the found update, select Download 
updates in background and specify the folder where updates will be placed. 

 
5 Click OK to close the screen and apply new settings. 

After this: 

 If you have not selected Download updates in background, you will be notified of an update 
found by the screen shown in step 3 of Manual Updating (page 21). To complete updating, 
follow the rest of the steps in this section. 

 If you have selected to Download updates in background, you will be notified of an update 
downloaded by the screen shown in step 4 of Manual Updating (page 21). To complete 
updating, follow the rest of the steps in this section. 

 

Manual Updating 
1 In the menu select Help -> Check for Updates. You will see the following screen:  
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Settings on this screen are intended for auto-updating and are discussed in the previous 
topic, Auto-Updating Parallels Desktop (page 20). 

To proceed with manual update click Check Now.  

2 Updater accesses the FTP server with Parallels Desktop updates and compares available 
updates with the installed version. If the wizard detects that the most recent version is 
installed, it shows the following screen: 

 
3 If the wizard finds a more recent version, the number of the newest version is displayed in 

the following screen. Click the Download button to start downloading. 
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4 After the update is downloaded, you will see the following screen. To install the update, 
click Quit Application and follow the same steps as when Installing Parallels Desktop (on 
page 12). 

 
 

Uninstalling Parallels Desktop 
To uninstall Parallels Desktop: 

1 Open the Parallels-Desktop-XXXX-Mac.dmg file from which you installed 
Parallels Desktop. 

2 Click the Uninstall icon. In the first uninstaller screen click the Continue button. 
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In the next screen click Uninstall. 

 
3 Enter your password if you are asked for it and press Enter on your keyboard. 

 
4 Uninstaller removes Parallels Desktop from your computer. When finished it displays the 

following screen. Click the Finish button. 
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C H A P T E R  3  

Creating Virtual Machine 

This chapter discusses the tasks you should perform when creating a new virtual machine. They 
are: 

 creating a virtual machine configuration, 
 installing a guest operating system, 
 installing the Parallels Tools. 

 

In This Chapter 
Creating Virtual Machine Configuration .............................................................................. 25 
Installing Guest OS ............................................................................................................... 45 
Installing Parallels Tools....................................................................................................... 48 
 
 

Creating Virtual Machine 
Configuration 

This section discusses what is virtual machine configuration and the process of creating a new 
virtual machine. 
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Understanding Virtual Machine Configuration 
Each virtual machine hardware configuration is defined by a special Parallels Desktop 
configuration file having the .pvs extension. It contains all of the information about virtual 
devices attached to the virtual machine and files connected to it. In general, two files make up a 
virtual machine, a configuration file and a hard disk image file (several virtual hard disks can be 
attached). Other files may not be attached. 

The following table explains all file types that may be related to a virtual machine: 

.pvs This is a virtual machine configuration file. One configuration file defines one 
virtual machine.  

One instance of Parallels Desktop can run only one opened configuration file, i.e. 
only one virtual machine. To run several virtual machines, you should launch 
several instances of Parallels Desktop. Typical configuration file can be easily 
generated using the New Virtual Machine Wizard (page 27). 

.sav This is a virtual machine saved state file. This file is created when you suspend a 
virtual machine and contains the state of the guest OS and its applications in the 
moment when suspend was invoked.  

See the Suspending/Resuming Virtual Machine (page 126) for more information. 

.hdd This is a virtual hard disk of a Parallels Desktop virtual machine.  

When you create a new virtual machine, the New VM Wizard prompts you to 
place a new virtual hard disk and .pvs configuration file into the same directory, 
however you may store these files in different folders. You may also attach an 
existing virtual hard disks to different virtual machines.  

More information about virtual hard disks can be found in the Hard Disk Images
(page 75) topic. 

.iso This is a CD or DVD-ROM image file. .iso image files are treated by an 
operating system as real CD/DVD discs. 

More information about .iso images is given in the CD/DVD Real Discs and 
Images (page 77) topic. 

.fdd This is a floppy disk image file created by Parallels Desktop. .fdd image files 
are treated by an operating system as real floppy disks. 

More information about .fdd images is given in the Floppy Disks and Disk 
Images (page 77) topic.  

.txt Serial and parallel ports can be emulated via output .txt files. See Serial Port 
Options (page 95) and Parallel Port Options. (page 96) 
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New Virtual Machine Wizard 
There is a special New Virtual Machine Wizard in Parallels Desktop that provides a means for 
creating new virtual machines for both new and experienced users.  

The wizard offers three methods of creating a virtual machine: Typical, Custom, and Blank. 
They differ in the ability to specify various settings, and the appropriate method should be 
chosen based on a user's experience with Parallels Desktop. Regardless of what method is 
selected, you will be able to configure virtual machines using the Configuration Editor (page 
80).  

Typical Virtual Machine 

Typical method is designed for new users and for fast virtual machine creation. When choosing 
this method you only need to specify: 

 the type and version of the guest operating system that will be installed; 
 the name of the virtual machine; 
 a directory for storing the virtual machine configuration file and a name of the configuration 

file. 

A virtual machine is created with the most common parameters for the selected guest operating 
system. A new hard disk image is created with a predefined size and format, a standard amount 
of memory is allocated, and so on. Users can later change the settings and add new devices 
using the Configuration Editor. 

Custom Virtual Machine 

When creating a custom virtual machine configuration, the wizard allows you to set virtual 
machine parameters directly in the process of creation. This is intended for experienced users. 
When creating a custom virtual machine configuration, the user is asked to define: 

 the type and version of the guest operating system that will be installed; 
 the amount of RAM the virtual machine will use; 
 whether you want to create a new virtual hard disk, attach an existing one, or not to add one 

at all. In the first case you should specify the parameters of the new disk: it's size and type 
and where to store the disk file. When attaching an existing disk you have to locate the disk 
image file. If you select not to add a hard disk at all you are able to do it later in the 
Configuration Editor; 

 the type of networking in the virtual machine. If you select Bridged Ethernet, the wizard 
will ask to choose the network adapter that should be connected to the virtual device; 

 a name for the virtual machine; 
 a directory for storing the virtual machine configuration file and a name of the configuration 

file. 

The CD/DVD-ROM drive, floppy drive, and sound device (if it is supposed for the selected 
guest OS) are added automatically. Serial ports are included in some guest OSes. Other 
additional devices can be added in the Configuration Editor. 
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Blank Virtual Machine 

Blank virtual machine has only memory in its configuration after creation. When you select this 
method, the wizard's Next button changes to Finish, and after you click it wizard creates the 
machine immediately. Nothing else needs to be defined. Devices can be added to blank 
configurations manually in the Configuration Editor. 
 

Creating Typical Virtual Machine 
After you get acquainted with virtual machine configuration options you may use the wizard to 
create special configurations. 

A typical virtual machine includes the following devices: 

 memory 
 hard disk drive 
 floppy drive 
 CD/DVD-ROM 
 network adapter 
 sound device (except for FreeBSD and MS-DOS configurations) 
 USB controller (in Windows 98/ME/2000/XP/2003 and all of the Linux typical 

configurations) 

OS/2 typical configuration includes a serial port.  

Amount of memory and hard disk size vary for different guest OSes. Look in the following 
table for memory amount and hard disk size provided for different guest operating systems. The 
virtual hard disk for typical virtual machines is always created in expanding format.  
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RAM, MB HDD size, 

MB

Windows 95 128 2000 

Windows NT 128 6000 

Windows 2003 384 8000 

Windows 3.11 64 2000 

Windows other 256 8000 

Linux 256 8000 

FreeBSD 256 8000 

OS/2 wrap 3;4 128 2000 

OS/2 wrap 4,5 
eComStation 256 6000 

OS/2 other 128 6000 

Solaris 256 12000 

MS-DOS 32 2000 

Other guest OSes 256 8000 

 



 Creating Virtual Machine 30 
 

To create a typical virtual machine: 

1 Open Parallels Desktop. Click the  button or select New VM in the File 
menu. The New Virtual Machine Wizard welcomes you. Click the Next button.  
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2 In this step the first option, Create a typical VM, is selected. If you are going to create a 
typical virtual machine, nothing needs to be changed on this screen. Click the Next button to 
continue to the next step.  
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3 Here you should specify the type and the version of the guest operating system you want to 
install on the new virtual machine. When the guest operating system is specified, click Next. 

 

 



 Creating Virtual Machine 33 
 

4 In this last step you should define a name for the virtual machine and indicate in which 
folder on the hard disk the virtual machine configuration file should be stored. By default 
the wizard will put it into a standard place with a standard name. (The default folder for 
Parallels virtual machines is specified in the Preferences->Common (page 68) window.) 

Enter a descriptive name for the virtual machine in the Virtual machine name field. The name 
should be no longer than 50 characters. 

In the Configuration file field the default path and name for the configuration file is shown. If 
you do not like the default name or path you may browse your file system to locate an 
appropriate folder and name. You may also make changes directly in the field. 

Click Finish to begin the process of creating your new virtual machine, or click Back to 
examine settings on the previous steps.  

After you click Finish, the new configuration is generated and opened in the Parallels 
Desktop window. The property page (page 63) is displayed. You may continue with 
installing the guest operating system (page 45) on the new virtual machine. 
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Creating a Custom Virtual Machine 

1 Open Parallels Desktop. Click the  button on the Command Button 
panel or select New VM in the File menu. The New Virtual Machine Wizard welcome screen 
will appear. Click the Next button. 
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2 The Select virtual machine configuration screen is opened. Select the second option, Create a 
custom VM configuration. Click Next to proceed. 
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3 On the Select guest OS screen you should specify the type and version of the guest operating 
system you want to install on the new virtual machine. When done, click the Next button to 
move to the next step. 
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4 On the Specify memory size screen you should set the amount of RAM for the new machine. 
You can choose any value from 4 to 1500 MB. We strongly recommend that you allocate no 
more than the half of the physical RAM installed on your computer.  

Memory size should be in multiples of 4 MB. You will receive error notification and will 
not be able to go further until specifying a value that meets this condition. 

To set memory value, use the slider, spin buttons, or type a value directly into the field.  

Click Next to move to the next step. 
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5 On the Select action type screen you have to decide whether you want to create a new virtual 
hard disk, attach the machine to an existing one, or not to add one at all. After specifying 
what the wizard should do, click Next. 
If you have selected to use an existing hard disk image, go directly to step 8 of the current 
instructions. 

If you have decided not to add a disk at all, proceed to step 9. 
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6 If you selected to create a new virtual disk on the previous step, you should specify its size 
and format. Disk formats are shortly explained on this wizard screen, but a more detailed 
description is given in the Hard Disk Images (page 75) topic.   

After specifying the required data, click Next.   
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7 On the Select an image file screen you should determine the path where the virtual disk 
image should be stored, and the name of the disk. 

The wizard prompts you to store the new hard disk image under the default path that is 
specified on the Common tab (page 68) in the Preferences window, in a separate folder. 
Files of each virtual machine are automatically stored in separate folders, that are named in 
the following format <guest OS>.<number of the machine of the same 
version - 1>. 

For instance, the first Windows 2000 virtual machine is proposed to store in the 
\win2000\ folder. For the second Windows 2000 VM \win2000.1\ folder is offered, 
and so on. 

If you don't like the default name or path you may browse for the right folder and name, as 
well as make corrections directly in the field. 

 
After you click Next the wizard checks if the specified folder exists, if not, permission for 
creation is asked: "Directory <name> does not exists. Do you want it 
to be created automatically?" Click Yes.  

Continue to the step 9 of the current instructions. 
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8 Since you decided to attach to the new VM an existing hard disk image (in step 5) you have 
to specify where this disk image is stored. Use the Browse button to locate it or type the file 
name with its path directly in the field. 

 
After you click Next the wizard searches the disk for the specified file, and if it does not find 
the file, you are notified that "The specified file <file name> does not 
exist. Please select a different file." 
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9 Here you will specify the type of networking for the new virtual machine.  

Select Bridged Ethernet if you want to access the Internet inside the virtual machine.  

Select Host-only Networking if you want to create a virtual network or you don't want to 
access the network outside your local computer. See Networking in Virtual Machine (page 
102) for detailed information about Bridged Ethernet and Host-only types of networking.  

If you do not have a physical network interface card or do not need a network adapter in this 
virtual machine, select the Networking is not required option. 

 

 
Click Next. If you have selected Host-only Networking or Networking is not required proceed 
to the step 11 of the current instructions. 
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10 If you have selected Bridged Ethernet networking for the new machine, on this screen you 
should specify which real adapter should be connected to the virtual drive. Select one in the 
list and click Next. 
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11 On the Select virtual machine configuration file screen you should determine the name of the 
virtual machine and the folder where the virtual machine configuration file should be stored 
and with what file name. 

Specify a descriptive name for the machine in the Virtual machine name field. The name 
should be no longer than 50 symbols. 

In the Configuration file field the default path and name for the configuration file is shown. 
The wizard offers to store the configuration file in the same folder with the new hard disk 
image (if you have created a new virtual hard disk for the machine). The name of the folder 
is described in the step 7 of the current instructions.  

If you don't like the default name or path you may browse for the right folder and name, as 
well as make corrections directly in the field.  

 
Click Finish after you specify the path and the name for the configuration file. If the folder 
does not exist the wizard displays notification: "Directory <name> does not 
exists. Do you want it to be created automatically?" Click Yes. 

New configuration will be created and opened in the Parallels Desktop window. 
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Installing Guest OS 
This section discusses how to install an operating system in a virtual machine.  

Installing a Guest Operating System 
Before starting guest operating system installation, the virtual machine should be configured 
and the guest OS distributive should be connected to it. In addition to installation from a CD or 
DVD, the guest OS distributive may reside in an image file(s): an .iso image of a CD/DVD, 
or an .fdd, .img , or .ima image of a floppy disk.  

CD/DVD .iso images can be made using the Parallels Image Tool included in Parallels 
Desktop distribution. For more information on Image Tool see the Using the Parallels Image 
Tool (page 164) chapter. Creating a floppy image is discussed in the Floppy Disk Images (page 
77) topic. 

General Steps: 

1 Start Parallels Desktop.  

2 Open or create a virtual machine configuration intended for installing a guest OS. 

To install from a physical CD/DVD or CD/DVD .iso image: 

1 Select CD/DVD-ROM drive and open its options tab. 

On the virtual machine property page (page 63) click on the desired CD/DVD-ROM drive to 
open its CD/DVD-ROM Options (page 91) in Configuration Editor. Make sure that the 
Enabled and the Connect at startup options are selected. 

2 Connect the CD/DVD-ROM drive to the guest OS distribution. 

If you install from a real CD/DVD:  

Select the Use real CD/DVD-ROM and specify which real drive to connect to the virtual device 
in the CD/DVD-ROM Drives list. 

Insert the CD/DVD disk with the operating system distribution into the appropriate drive of 
your computer. 

If you install from an .iso image file: 

Check the Use image file option and specify the path to the .iso distribution file in the 
Image File field. 

3 Specify the IDE slot for the virtual CD/DVD-ROM. In the Connect to list select 0:1. 

4 Save the virtual machine configuration. See the Saving Virtual Machine Configuration 
(page 81) subtopic in the Editing Virtual Machine Configuration section.  

5 Start your virtual machine by clicking Power On  on the toolbar. Follow the installation 
instructions for the operating system. 
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To install from a floppy image: 

1 Select the floppy drive and open its options tab. 

On the virtual machine property page (page 63) click on the Floppy resource to open Floppy 
Options (page 87) in the Configuration Editor. In the Floppy Options tab, make sure that the 
Enabled and the Connect at startup options are selected. 

2 Connect the floppy drive to the guest OS distribution. 

For this, specify the path to the floppy image file with the distributive in the Image File field. 

3 Save the virtual machine configuration. See the Saving Virtual Machine Configuration 
(page 81) subtopic in the Editing Virtual Machine Configuration section. 

4 Start the virtual machine by clicking Power On  on the toolbar. Follow the installation 
instructions for the operating system. 

When Installing on Non-empty Hard Disk 

If you install a guest operating system onto a hard disk where the guest OS was previously 
installed, you have to change the boot sequence:  

 after you perform the general steps listed above, open the Booting Options tab of the 
General Options (page 81), 

 set the boot sequence to [CD-ROM, Hard Disk, Floppy] or [Floppy, Hard Disk, CD-ROM], if you 
installed from a CD/DVD or a floppy disc respectively 

During installation, when the guest OS reboots for the first time, return the boot sequence to 
booting from hard disk: 

 When the virtual machine is off, set [Hard Disk, Floppy, CD-ROM] sequence, save the 
settings, and start the guest OS.  

 

Configuring X Window System in FreeBSD Guest OS 
If you want to use the X Window System graphic shell in a FreeBSD guest OS, you should 
configure it manually. Running automatic configuration command X -probeonly or X -
configure may not work. The X Window System can be configured using xorgconfig 
text utility or xorgcfg graphical utility. You need root privileges to run them. 

To start manual configuration: 

1 Issue one of the following commands in the command line: 
su -l root -c xorgconfig  

or 
su -l root -c xorgcfg 

2 Enter the root password when you are asked for it. 

When configuring set the following: 

1 Select Generic VESA compatible video card. 

2 Select 4096K of video memory. 
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3 Select screen resolution for a color depth. You may specify single resolution for any color 
depth. For instance, specify 640x480 resolution for 8-bit color, 800x600 resolution for 16-
bit color, and so on. Do not specify several resolutions for a color depth, because upon 
startup, X window will select the greatest one. 

You may set a single resolution for a particular color depth (for instance, if you are going to 
work with 16-bit color only, select any single resolution for it), and later select only this 
color depth for your configuration . 

4 Select preferred color depth for your configuration. 
 

 

 



 48 
 

C H A P T E R  4  

Installing Parallels Tools 
Parallels Desktop includes specially developed tools that help you use your virtual machines in 
the most comfortable and efficient way. The current version of Parallels Desktop is supplied 
with tools for the following guest operating systems: 

 Windows versions 95, 98, ME, NT, 2000, XP, 2003; 
 OS2 and eComStation; 
 Solaris.  

We provide PRL8029 driver for Solaris guest OS that should be installed if you want the 
Solaris virtual machine to support networking.   

 For other guest operating systems we provide PRL8029 network adapter driver. 

Most of the tools are located on the CD image VMTOOLS.ISO, however OS/2 network drivers 
that are conveniently installed during guest OS installation are also located on the floppy disk 
image VMTOOLS.FDD. Both CD and floppy images can be found in the directory where 
Parallels Desktop is installed: /Library/Parallels/Tools. 

 

In This Chapter 
Parallels Tools Overview ...................................................................................................... 49 
Windows Tools Installation .................................................................................................. 52 
Windows 98 Sound Driver Installation................................................................................. 53 
Windows NT Tools Installation ............................................................................................ 54 
OS/2 and eComStation Tools Installation............................................................................. 55 
Solaris Network Driver Installation ...................................................................................... 57 
Uninstalling Parallels Tools in Windows Guest OSes .......................................................... 58 
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Parallels Tools Overview 

Tool Description
Clipboard Synchronization Tool The Clipboard Synchronization Tool syncs the guest OS 

clipboard and the primary OS clipboard, allowing you to 
easily exchange texts and pictures between the primary OS 
and the guest OS. Currently you can only exchange.bmp
pictures having up to a 128KB size.  

In you enable the Clipboard Synchronization Tool in all of 
your guest OSes, all of them will share the same clipboard 
with the primary OS. 

In all the Windows guest OSes, this tool is installed 
automatically when you perform Parallels Tools installation. 
In OS/2 and eComStation you must install it manually. 

Time Synchronization Tool The Time Synchronization Tool allows the guest OS to keep 
the same system time as the primary OS. Without this tool 
the guest OS system time may differ from that of the 
primary OS. 

This tool also allows you to maintain a constant difference 
between the guest OS and primary OS system time. You 
may configure this tool while the guest OS is running. See 
Time Synchronization Tool Options (page 134) to learn how 
to perform this task. 

Note. Before starting the Parallels Time Synchronization 
Tool, all other time synchronization services must be 
stopped in order to avoid potential conflicts. 

Video Driver The best graphical mode available in Windows NT and 2000 
guest operating systems without this driver is 16-color VGA 
with 640x480 resolution. The video driver allows Parallels 
Desktop to use SVGA graphical modes in guest OS 
monitors.  

In Windows XP/2003 the video driver is required for the 
mouse tool and is chosen automatically when you select the 
mouse tool installation. 

Note. If you install the video driver you will not be able to 
use VGA modes. To return to VGA, you must uninstall the 
Parallels Tools. 
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Tool Description
Mouse Synchronization Tool The Mouse Synchronization Tool enables the mouse to be 

captured and released without a special hot key combination 
defined in the Hot Key Combinations (page 74) tab of the 
Preferences window. Using this tool makes mouse 
movements smoother and improves the system's reaction to 
the mouse.  

Sound Driver Parallels Tools pack includes an AC'97 sound driver for 
those guest operating systems that do not contain a standard 
AC'97 driver.  

Sound drivers for Windows XP/2003 are not included in the 
Parallels Tools pack since these operating systems contain 
sound drivers in their installations. 

Shared Folders Tool This tool is needed for a guest OS to view shared folders. 
Without it, the guest OS can not use the shared folders 
although they may be set up in your virtual machine 
configuration. To learn more about shared folders see Using 
Shared Folders (page 105). 

Disk Compacting Tool Parallels Desktop uses virtual hard disks of two types: plain 
and expanding. Expanding virtual disks grow in size as you 
work with them. The Disk Compacting Tool reduces the size 
of expanding virtual hard disks by cleaning up unused disk 
space. See Compacting Virtual Disk (page 140) for 
guidelines on using this tool. 

This tool does not reduces the size of plain virtual disks.  
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Tool Description
Network Adapters and Drivers:  

 Parallels Network Adapter 
Driver This Ethernet driver for the RTL8029 adapter is specially 

developed for Parallels Desktop to improve network 
performance. We recommend that you install this driver 
whenever possible.  

 RTL8029 CD with Parallels Tools includes native Realtek (all except 
for Solaris driver) drivers for the RTL8029 network adapter 
for many different operating systems. They are located in 
the Drivers\Network\RTL8029 directory of the vmtools.iso
CD image. 

Some guest operating systems such as Windows 2000, 
contain an RTL8029 driver in their distributions, whereas 
others like Windows 2003 and OS/2 do not include this 
driver at all.  

Note. Unlike other guest OSes, a Solaris guest OS requires 
an RTL8029-compatible driver to be installed to support 
networking. Otherwise networking will not be possible. 

An RTL8029-compatible driver for Solaris has been created 
by an independent developer and is distributed under the 
terms of BSD license. A slightly modified version of this 
driver is included into the Parallels Desktop distribution. 
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The table below shows which tools have been developed for which operating systems. 

Windows 

 
95, 98, XP, 
ME 2000 XP, 2003 

OS/2, eCS 

 

Solaris 

 

other 

 

Clipboard + + + +   

Time + + +    

Video + + +    

Mouse  + + +   

Sound + +  +   

Shared Folders  + +    

Disk Compacting + + +    

Network Drivers:       

Parallels Network Adapter 
Driver  + +    

RTL8029 + + + + + + 

In Windows guest OSes you can control the tools during guest OS execution. See the Parallels 
Tools Center (page 132) section to learn how to do this. 
 

Windows Tools Installation 
To install Parallels Tools in a Windows guest OS do the following: 

1 Make sure that the virtual machine configuration includes a CD/DVD-ROM drive and it is 
enabled (the Enabled check box is selected). See CD/DVD-ROM Options (page 91). 

2 Start your guest operating system and log in. In order to install tools properly do not begin 
the installation until OS completes its startup and you log in. 

3 Select Install Parallel Tools in the Parallels Desktop VM menu.  

4 You are warned about the necessity of having the guest OS fully started and being logged 
in: "You can install the Parallels Tools only if the guest 
operating system is running and you are logged in. If you are 
not logged in now, select Cancel and run Parallels Tools 
installation later." If you are logged in, click OK to start installing.  

5 Parallels Tools Setup wizard starts and greets you. Click Next to move to the Choose 
Destination Location screen. If you do not like the default directory, select another one using 
the Change button. Then click Next. 
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6 On the Setup Type screen you should choose between the complete setup and a custom 
one. The complete setup installs all of the tools available for your guest OS. If you select 
custom setup, the Select Components screen asks you to select the desired tools from the 
tools available for your guest OS. 

7 Choose the program folder on the Select Program Folder screen, then the Check Setup 
Information screen displays the options selected. If they are correct, click Next to begin the 
installation. 

8 After the wizard copies tools, the Installation Completed screen asks if you want to restart 
the computer now. In all of the Windows guest OSes, except 98 and NT, you must restart 
the virtual machine after this setup procedure. Accept the selected option and click Finish. 
The virtual machine will be restarted and ready for work with the tools installed.  

Notes: 1. In a Windows 98 guest OS, the Sound Driver requires you to perform additional steps 
after this setup. Proceed to Windows 98 Sound Driver Installation (page 53). 

2. In a Windows NT guest OS, proceed to Windows NT Tools Installation (page 54) to 
complete setup in this guest OS. 

Troubleshooting When Installing Tools 

Parallels Tools installation is invoked by Windows AUTORUN feature for CD/DVD-ROM 
drive. It is enabled by default, however if you have disabled it manually, nothing happens after 
you select the Install Parallels Tools command. (In any case, the vmtools.iso CD image will 
be connected to the virtual machine CD-ROM drive, however it is not visible to the user.) To 
solve this problem do one of the following: 

 Enable AUTORUN function for CD-ROM drive in guest Windows. 
 Start tools installation manually. 

Open the contents of the vmtools.iso in Windows Explorer, find PrlTools.exe file, 
and start it. 

 

Windows 98 Sound Driver Installation 
The Sound Driver for a Windows 98 guest OS requires additional steps after the general 
Parallels Tools installation described in Windows Tools Installation (page 52). 

To install AC'97 Sound Driver in Windows 98: 

1 Open the Control Panel. To do this, click the Start system menu, select the Settings item, 
and then Control Panel. 

2 Double click the System icon to open the System Properties window. In the System 
Properties window select the Device Manager tab. 

3 Locate the PCI Multimedia Audio Device in the hardware list. Select it and click the 
Properties button. 

4 In the PCI Multimedia Audio Device Properties window click the Reinstall Driver button. 

5 In the Update Device Driver Wizard select the Sound, video, and game controllers item and 
click the Next button. 

6 In the second wizard screen select the second option: Display a list of all the drivers in a 
specific location, so you can select the driver you want, and click Next. 
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7 On the screen asking you to select the type of device click the Next button. 

8 In the next wizard screen click the Have Disk button. The Install From Disk window is 
opened, in the Copy manufacturer's file from: field type the following path "C:\Program 
Files\Parallels\Parallels Tools\Sound" and click OK. 

9 In the Select Device window select the AC'97 Audio and click OK. 

10 In the Update Device Driver Wizard click the Next button. When the wizard asks, insert 
disc (or connect CD-ROM image file) with your Win98 distribution and type path to it in 
the field Copy files from. Click OK button. After wizard finishes copying files, click Finish 
button in its window. 

11 Close the windows with AC'97 audio properties and system properties. 

12 Restart the virtual machine if the wizard asks you to do so for the new settings to take effect.  
 

Windows NT Tools Installation 
To install Parallels Tools in Windows NT: 

 Perform the installation procedure described in the Windows Tools Installation (page 52) 
topic. It is enough to install such tools as Clipboard Synchronization and Mouse 
Synchronization Tools. 

 Perform these specific steps for installing the Video Driver and Sound Driver: 

Video Driver Installation 

To install the Video Driver do the following: 

1 Open the Control Panel. For this click the Start system menu, select the Settings item, and 
then Control Panel.  

2 Double click the Display icon to open the Display Properties window. 

3 In the Display Properties window select the Settings tab. Then click the Display Type button. 

4 In the Display Type window select the Change button. 

5 In the Change Display window select the Manufacturers --> Parallels and Display --> Parallels 
Video Driver. Click OK. 

6 In the Third-party Drivers window click Yes. 

7 The Installing Driver window informs you of the completed installation. Click OK. 

8 Click the Close button in the Display Type window. 

9 Click the Close button in the Display Properties window. 

10 Click the Yes button in the System Settings Change window to restart the guest OS. 

Note: You must restart the virtual machine after this setup procedure. 

AC'97 Sound Driver Installation 

To install the AC'97 Sound Driver do the following: 

1 Open the Control Panel. Click the Start button in the system menu. Then select the Settings 
item, and then Control Panel. 
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2 Double click the Multimedia icon to open the Multimedia Properties window. 

3 In the Multimedia Properties window select the Devices tab. Then select Audio Devices from 
Multimedia devices: tree. Click Add button. 

4 In the Add window select the Unlisted or Updated Driver from List of Drivers. Click OK. 

5 In the Install Driver window click the Browse button and select the sound driver path. 

If you have installed Parallels Parallels Tools to the default location, select C:\Program 
Files\Parallels\Parallels Tools\Sound. 

If you have installed Parallels Tools to another directory, you should locate this directory. 

Click OK. Then click OK in the Install Driver window. 

6 In the Third-party Drivers window click Yes. 

7 The Add Unlisted or Updated Driver window informs you that you are about to install the 
AC'97 Audio Driver. Click OK. 

8 Click OK in the About AC97 Audio Driver window. 

9 Click OK in the System Settings Change window. 

10 Click Close button in the Display Type window. 

Note: You must restart the virtual machine after this setup procedure. 
 

OS/2 and eComStation Tools Installation 
All of the OS/2 and eComStation tools can be installed from the vmtools.iso CD image. 
Network drivers can also be installed from the floppy disk image file vmtools.fdd during 
operating system installation. The latter is easier in most cases. 

Before starting the installation you should connect the CD-ROM image with Parallels Tools to 
your virtual machine CD-ROM drive. Do the following: 

 Select Install Parallels Tools in the Parallels Desktop VM menu. 

Mouse Synchronization Tool Installation 

The Mouse Synchronization Tool consists of the mouse driver and the video filter.  

Note: To install the Mouse Synchronization Tool you should have a VESA video driver 
installed, such as SDD or GENGRADD. For instructions on how to do this refer to OS/2 
documentation. 

To install the mouse tool: 

1 Click the Drives icon on the system panel. Select the CD-ROM drive and Drivers\Mouse\OS2 
directory on it. 

2 Launch the INSTALL.CMD batch file. The INSTALL.CMD copies files and make 
necessary modifications to the CONFIG.SYS file. 

3 Restart the guest OS/2 operating system. 
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Note: The Mouse Synchronization Tool increases performance of the guest OS/2 operating 
system under Citrix. 

Clipboard Synchronization Tool Installation 

In OS/2 and eComStation you must launch the Clipboard Synchronization Tool manually. This 
tool is not a tool itself but an ordinary application, and should be treated as such. If you want the 
Clipboard Synchronization tool to start automatically when your guest operating system is 
started: 

 include the tool file PrlClip.exe into autostart group (startup.cmd or another file as 
it is done in your operating system). 

The Clipboard Synchronization Tool is located in the ClipBrd\OS2 directory on the CD-ROM 
containing Parallels Tools. 

Sound Driver Installation 

Note: Before installing the Sound Driver you should have multimedia support installed in OS/2 
guest OS.  

To install the Sound Driver: 

1 Click the System Setup icon on the system panel.  

2 Select the Install/Remove line, and then select Multimedia Application Install. 
3 In the IBM Multimedia Presentation Manager/2 - Installation window choose CD-ROM drive, 

then Drivers\Sound\OS2 directory. Select the  ALC Codec feature and click the Install button. 

4 Restart the OS/2 guest operating system. 

Network Driver Installation 

Below we consider the installation of the Realtek RTL8029 driver inside the OS/2 Warp version 
4.0.  

1 Click the System Setup icon on the system panel. 

2 Click the MPTS Network Adapters and Protocol Services icon to open the Multi-Protocol 
Transport Services window. 

3 Click Configure. 

4 In the Configure window that opens, click Configure again to open the Adapter and Protocol 
Configuration window. 

5 Click the Other adapters button below the Network Adapters section of the window to open 
the Copy Additional Network Adapter Drivers window. 

6 Specify the path to the Parallels driver on CD-ROM disc image. The path should be: 
 <CD-ROM drive>\Drivers\Network\RTL8029\NDIS2OS2

7 Click OK. The Parallels network adapter driver will be copied. After this you can see the 
name RTL8029 PCI Ethernet Adapter included in the Network Adapters list. Select this name. 

8 Click Change in the Network Adapters section of the window to change the current network 
adapter into the selected one. 
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9 Click OK when the message "Are you sure you want to change this 
network adapter?" is displayed. After you click OK, the RTL8029 PCI Ethernet 
Adapter appears in the appropriate field of the Current Configuration section of the window. 
Now if you click Edit in the Current Configuration section of the window, you will see that 
you do not need to configure any driver properties, because it is self-configurable.  

10 Click OK when finished. 

11 Close both the Configure and Multi-Protocol Transport Services windows.  

12 Click Exit in Update CONFIG.SYS window. 

Exit the configuration program and restart the guest OS. 
 

Solaris Network Driver Installation 
Unlike other guest OSes Solaris does not support the RTL8029 network driver emulated in 
virtual machines. To add RTL8029 support to a Solaris virtual machine you need to install the 
RTL8029 network adapter driver. We have created the special network.sh script that helps 
you to do this, or you may install and configure the driver manually. Both ways are described 
below.  

Before Installing the Driver 

Before installing the driver perform the following steps: 

1 Make sure that the virtual machine configuration includes a CD/DVD-ROM drive and it is 
enabled. See CD/DVD-ROM Options (page 91). 

2 Start your guest operating system. 

3 Connect the CD image with tools, vmtools.iso, to the CD/DVD-ROM drive of the 
virtual machine: 

 right-click the CD/DVD-ROM icon on the status bar and select the Connect image menu 
item (instead you may select Devices->CD/DVD-ROM <number>->Connect Image in the 
Parallels Desktop menu); 

 browse for vmtools.iso in the folder where you installed Parallels Desktop. 

Proceed to installing the RTL8029 network driver using the network.sh script or manually. 

To install the RTL8029 network driver using network.sh script: 
1 In the shell, run the 
cd /cdrom/PRLTOOLS/Drivers/Network/RTL8029/SOLARIS/ 

command to move to the respective directory. 

2 Issue the following command to begin installing the driver 
./network.sh 

3 You are sequentially informed that the driver is being extracted, compiled, and installed. 
When it is finished, you are asked "Will you receive IP addresses from 
DHCP server?"  If IP addresses on your network are managed by DHCP server proceed 
to step 4, otherwise proceed to step 5. 
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4 If IP addresses on your network are managed by DHCP server, type "Y" and the script will 
configure the DHCP client. Proceed to step 6.  

5 If IP addresses on your network are NOT managed by DHCP server, type "N" and then 
specify an IP address for your virtual machine, network address, network mask, and default 
gateway IP address when you are asked for them.  

6 Restart the guest operating system by issuing the command 
init 6 

To install the RTL8029 network driver manually: 
1 In the shell, issue the following command to get root privileges: 
su 

Enter the password to the root account when you are asked for it. 

2 As a root run the following commands:  
cd /tmp 
gzcat /cdrom/PRLTOOLS/Drivers/Network/RTL8029/SOLARIS/ni0.8.11.tgz|tar 
xf - 
cd ni-0.8.11 
/usr/ccs/bin/make install 
./addni.sh 

3 If IP addresses on your network are managed by DHCP server issue the following 
commands: 

touch /etc/hostname.ni0 
touch /etc/dhcp.ni0 

If IP addresses on your network are NOT managed by DHCP server, see the Solaris System 
Administration Guide. 

4 Leave the root account by running the command 
exit 

5 Restart the guest operating system by issuing the command 
init 6 
 

Uninstalling Parallels Tools in Windows Guest OSes 
To uninstall Parallels Tools in all Windows guest operating systems except Windows NT, you 
should activate the same wizard as when installing. Do the following: 

1 Select Install Parallel Tools in the Parallels Desktop VM menu.  

2 Parallels Tools Setup wizard performs the diagnostics of the operating system and asks Do 
you want to completely remove the selected application and all of its components? Click Yes 
to begin the process.  

3 After the wizard removes the tools, the Uninstallation Completed window asks if you want to 
restart the computer now. Accept the selected option and click Finish. The virtual machine 
will be restarted.  

4 After the OS is started up, the System Settings Change screen asks Do you want to restart 
your computer now? Click Yes. When the virtual machine is restarted once more, the tools 
are completely uninstalled.  
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Note: After uninstalling Parallels Tools and restarting the virtual machine, the guest operating 
system may display a warning that it should be restarted once more. In this case restart the guest 
operating system one more time to ensure its correct functioning. 

Uninstalling Tools in Windows NT 

In Windows NT Parallels Tools can be uninstalled using standard operating system techniques. 
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C H A P T E R  5  

Interface Basics 

This chapter provides information about Parallels Desktop window and its controls.  

 

In This Chapter 
Main Window ....................................................................................................................... 60 
Property Page ........................................................................................................................ 63 
Console View........................................................................................................................ 64 
Status Bar .............................................................................................................................. 65 
Text Size ............................................................................................................................... 66 
Making Screenshots .............................................................................................................. 66 
 
 

Main Window 

 

 



 Interface Basics 61 
 

The Parallels Desktop window displays an opened virtual machine and a set of visual controls 
for managing its behavior. If a virtual machine is not started, only its configuration and 
resources, i.e. connected devices, are seen. This is called property page view.  See 
Property Page (page 63) to learn more about this. When you start the virtual machine, its 
console (page 64) is opened and acts as the display of a real computer.  

The visual controls that help in managing virtual machine behavior are the: 

 Parallels Desktop menu; 

 Toolbar; 

 Status bar. 

The status bar is described in a separate topic; see Status Bar (page 65). 

Toolbar 

Toolbar buttons are used to: 

 Start a virtual machine. See Starting Virtual Machine (page 122); 
 Shut down virtual machines. See Shutting Down and Resetting Virtual Machine (page 125); 
 Reset a virtual machine. See Shutting Down and Resetting Virtual Machine (page 125); 
 Suspend/resume a virtual machine. See Suspending/Resuming Virtual Machine (page 126); 
 Expand a virtual machine screen to the full screen of your display. See Switching Virtual 

Machine to Fullscreen Mode (page 124); 
 Switch between property page view and console view. See Console View (page 64) and 

Property  (page 63)Page; 

Most of the toolbar buttons become active when you start the virtual machine. When the virtual 

machine is stopped, only the Power On Virtual Machine button is active letting you start the 
machine. 

If you click a toolbar button it becomes visibly pressed reflecting the current virtual machine 

state. On the picture above, the Power On Virtual Machine  and the Property Page View  
buttons are pressed, that means firstly, the guest OS is running and, secondly, you are looking at 
the virtual machine's property page. 

By default the toolbar is located at the top of the Parallels Desktop window. You may place it to 
the left or to the right of the window if you'd like. Parallels Desktop will keep this toolbar 
position next time you launch the system. 

To change a toolbar position: 

1 In the menu, select Parallels Desktop->Preferences to open the Preferences screen. 

2 In the Preferences screen, select the User Interface tab.  

3 In the User Interface tab, select the preferred position in the Toolbar placement option. 

4 Click OK to activate settings. 
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Simplifying Parallels Desktop Window 

You can simplify the Parallels Desktop window by hiding some of its components such as the 
toolbar and status bar.  

To hide the toolbar/status bar: 

 Click Toolbar/Status Bar in the View menu.  

You can make them visible at any time with the same action. Visible window elements are 
marked with checkmarks.  
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Property Page 

 

When you open an existing virtual machine or create a new one its property page is displayed. 
The upper part of the page, Configuration, displays the virtual machine name, name of the 
configuration file with the path, and general VM settings: guest operating system type and 
version (regardless whether or not it is installed), acceleration level, last modification date, etc. 
These settings may be changed; and if you click on any of them, the Configuration Editor (page 
80) will be opened on the appropriate page. 

Note. The name of the virtual machine is not linked to the Configuration Editor, however it can 
be changed on the General Options (page 81) tab. 

The Resources list shows all devices connected to the virtual machine and their current options. 
To  edit any device simply click device name. The Configuration Editor will open the tab 
corresponding to that device. 

The command button panel in the bottom of the property page contains buttons for creating a 
new virtual machine (page 25), browsing hard disk for a virtual machine to open (page 78), 
editing virtual machine configuration (page 80), and also saving an opened virtual machine 
configuration (page 81). 

Parallels Desktop allows you to pick for the property page the text size that fits you the best. See 
Text Size (on page 66) for details.  
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When Running Guest OS 

The property page remains available when a guest OS is running. You may open it to check the 
VM configuration. However, editing of the configuration is prohibited and the command button 
panel is disabled. 
 

Console View 

 

You interact with a running virtual machine via its console which is opened when you start the 
virtual machine (page 122). If you have a guest operating system installed it will be displayed 
on the console exactly as the primary OS is displayed on a real monitor.  

During guest OS execution all toolbar buttons and many of the menu commands become active. 

When a guest operating system is running, you can switch between the console and the property 
page. To switch to the property page while in the console view, do one of the following: 

 click Property Page View  on the toolbar, 
 select Console View in the View menu.  
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To return to console view while in the property page, do one of the following: 

 click Console View  button, 
 select Console View in the View menu.  

Fullscreen Mode 

Guest operating systems can be executed in fullscreen mode, making the Parallels Desktop 
menu, toolbar, and status bar become hidden. For detailed information see Switching Virtual 
Machine to Fullscreen Mode (page 124). 

Console Screenshots 

You can make screenshots of the console while the virtual machine is active. See Making 
Screenshots (page 66) for details. 
 

Status Bar 
The status bar displays information when the virtual machine is running. The left side of the 
status bar displays prompts describing the menu item currently selected. 

Each device (except memory) connected to the virtual machine is represented by an icon on the 
right side of the status bar. 

 

The following devices have icons onto the status bar: 

 hard disk , 

 CD/DVD-ROM ,  

 floppy disk drive , 

 network adapter , 

 serial port , 

 parallel port , 

 sound device , 

 USB controller . 

When a device is involved in the current process, it is indicated by circle on its icon: 

 green circle   when reading is being performed, 

 orange circle   when writing is being performed.  

If a device can be connected/disconnected when running a guest OS (page 127) (CD/DVD-
ROM, floppy drive, network adapter, serial and parallel ports a sound device, and USB), these 
operations can be executed using the device context menu. Right-click on the device icon to 
display its context menu and select the command you need.  
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The picture below shows the context menu of the CD/DVD-ROM drive. 

 

 
 

Text Size 
Parallels Desktop allows to adjust text size of the property page. Use View->Text Size-> Increase 
Text Size and Decrease Text Size commands. To return to initial text size click Reset Text Size 
command. 
 

Making Screenshots 
Parallels Desktop allows you to make screenshots of the guest operating system window when 
guest OS is running. Click Console Screenshot in the VM menu. Type or select a name and a 
directory to store the screenshot file. Parallels Desktop saves screenshots as .png files in a 
MAC primary OS. 
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C H A P T E R  6  

Managing Virtual Machines 

This chapter discusses multiple ways to change a virtual machine configuration and provides 
information on setting user preferences and using virtual disks.  
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Setting Parallels Desktop 
Preferences 

Settings that affect more than one virtual machine are contained under a single menu entry. To 
edit general preferences click Preferences in the Parallels Desktop menu. 

Common, User Interface, and Hot Key preferences are assigned for each user. Memory and 
DHCP preferences concern all users that work on a particular computer and all virtual machines 
they launch. 
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Common 

 

Settings on this tab can be different for each user of your computer. 

Workspace: 

 Default directory for virtual machines. A directory proposed by Parallels Desktop to a user 
for saving new configuration files and hard disk images is specified on this tab in the Default 
directory for virtual machines field. It is possible to choose another location when creating a 
configuration file or hard disk image. 

 Two options, Load recently used VM at startup and Show startup dialog, determine what 
happens at Parallels Desktop startup. By default, both options are selected and the 
application starts with the last used virtual machine configuration. If this configuration is 
already opened in another instance of Parallels Desktop or the configuration file cannot be 
found on the given path (for instance, it has been moved to another folder or deleted), then 
Startup Options dialog is opened upon Parallels Desktop startup. 
If the Load recently used VM at startup option is selected while the Show startup dialog 
option is turned off, Parallels Desktop will open a blank virtual machine upon startup if it is 
unable to open the last used virtual machine. 

If the Load recently used VM at startup option is not selected while the Show startup dialog is 
turned on, Parallels Desktop always starts with the Startup Options dialog. 

If both options are turned off, Parallels Desktop starts with a blank virtual machine. 
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More information about what happens upon Parallels Desktop startup can be found in 
Selecting and Opening Virtual Machine (page 78) and Startup Options Dialog (page 79) 
topics.   

VM shutdown behaviour: 

Radio buttons in this group control the effect upon selecting the Parallels Desktop -> Quit 
Parallels Desktop menu item and clicking the Macintosh close button  for the Parallels 
Desktop window.  

 If you want all virtual machines to be suspended upon these actions, select the Suspend VM 
radio button.  

 If you want all virtual machines to be stopped upon these actions, select the Power Off radio 
button. 

 When you are unsure if you want virtual machines to stop or to suspend, select the Ask me 
what to do radio button. Every time you click the Mac close button  or select the Parallels 
Desktop -> Quit Parallels Desktop menu command, you will be asked to choose whether you 
want to stop or suspend the virtual machine. 
See the Suspending/Resuming Virtual Machine (page 126) topic to learn about 
suspending/resuming virtual machines. 
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Memory 

 

On this tab the maximum amount of physical memory (RAM) the system should reserve to all 
simultaneously running virtual machines on your computer can be adjusted. This setting applies 
to all users of your computer. 

The maximum memory allowed depends on the physical RAM size of your computer. Some 
memory must be reserved for your primary operating system. From the remainder you can 
select the maximum RAM allowed for Parallels Desktop. If you have one instance of a virtual 
machine running, it may use all the memory allocated here. In the case of several 
simultaneously running virtual machines this memory will be shared between them. Memory for 
a particular virtual machine is set on the Memory tab (page 86) in the Configuration Editor. 

Memory amount should be in multiples of 4. If it doesn't then you will receive an error 
notification when trying to save memory options. To set an appropriate memory amount you 
may use the slider, the spin buttons in the Reserved memory limit field, or type a value directly 
into the field.  
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DHCP 

 

Parallels Desktop provides host-only network accessible only to a primary system and virtual 
machines running on it. Methods of configuring different types of host-only network are 
discussed in the Creating Host-Only Network (page 103) topic.  

The DHCP tab is intended for specifying a range of IP addresses to be assigned to virtual 
machines by Parallels DHCP server when configuring host-only networks with dynamic IPs.  

The Scope start address and Scope end address values determine the first and the last IP 
addresses. The first address of this scope DHCP server usually assigns itself. The second 
address is usually given to the primary system. Others are assigned to virtual machines. Scope 
start address and Scope end address should belong to the same subnet. 

Subnet mask should be set in the Scope mask field. 

Note. Before changing DHCP scope settings make sure that there is no virtual machine running 
in Host-only networking mode. 

To check the networking mode of a running virtual machine: 

1 Point the mouse cursor to the network adapter icon   in the status bar,  

2 Check the Mode line in the tooltip. 
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User Interface 

 

User interface preferences can be different for each user of your computer. 

Look and Feel: 

 Toolbar placement option controls the position of the toolbar. By default the toolbar resides 
at the top of the Parallels Desktop window. 

 Show tooltips for command buttons option controls the appearance of tooltips for the toolbar 
buttons and the command buttons on the property page (see Property Page (page 63)). By 
default this option is selected.  

 Show tooltips for devices on status bar option controls the appearance of tooltips for devices 
connected to the virtual machine when it is running. By default this option is selected.  
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Fullscreen Options: 

 Allow to change guest screen resolution. If this option is selected, a virtual machine 
switched to fullscreen mode tries to change its screen resolution to the Mac OS X screen 
resolution. This can be done when the video driver from Parallels Tools (page 48) is 
installed in your guest OS. 

 Allow to change Mac OS X screen resolution. If this option is selected, resolution of your 
Mac monitor is changed to the resolution of the guest OS when a virtual machine is 
switched to fullscreen mode. Note that this option has lower priority than the previous one, 
so if both are selected this option is active only when the Allow to change guest screen 
resolution option can not be applied.  

 Advanced button opens the Advanced Fullscreen Options dialog described below in this 
topic. 

Restore Hidden Messages: 

 If the Parallels Desktop wants to attract user's attention to an operation that is going to be 
performed or to some situation, it displays a message that contains a description and a Do 
not show this message again check box. If you select this check box, in the same situation 
the message will not be displayed. Restore hidden messages button on this tab allows you to 
reactivate all suppressed messages. 
The system does not allow you to suppress messages reporting potentially dangerous 
situations. 

Advanced Fullscreen Options 

 

 Animation mode contains the list of animations that are displayed when switching a virtual 
machine to fullscreen mode. Duration slider allows you to select the speed of this animation. 

 Exit fullscreen on focus lost. If this option is on, a virtual machine running in fullscreen 
mode exits this mode and returns to the usual windowed mode when focus is moved to 
another application. For instance this may happen due to a message box appearing in 
another application. 

 Always stay on top in fullscreen. When this option is on, the display of a virtual machine in 
fullscreen mode is always above all other windows and dialogs. If you want to view the 
dashboard or some other pop-up window, this option should be off. 
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Hot Keys 

 

Hot key combinations can be different for each user of your computer. 

Release Input Key Combination 

 This key combination is used for releasing the keyboard and mouse that are captured in the 
virtual machine screen. The default hot key is Ctrl+Option(Alt). 

Note. You can free the mouse and the keyboard from the virtual machine screen without 
pressing the hot key combination if you install the Parallels Tools. See Installing Parallels 
Tools (page 48) section to learn if this package is available for your guest operating system, 
and Capturing and Releasing the Keyboard and the Mouse (page 123) topic. 

Fullscreen Toggle Key Combination 

 This combination is used for switching a virtual machine screen from the Parallels Desktop 
default window size to the fullscreen mode and back. The default hot key is 
Option(Alt)+Enter. 

Note. See Switching a Virtual Machine to Fullscreen Mode (page 124) for information on 
running virtual machine in fullscreen mode. 
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Mouse Right Click Simulation 

 This key combination is used to imitate mouse right-click for a mouse that does not have the 
right key. The default hot key is Ctrl+Shift+mouse click.  

In addition to the key combination you may turn on another imitation method, Delayed Right 
Click. Preferred delay is specified on the slider. 

Both methods of imitation can be turned on at the same time. 

Note. See Keyboard Shortcuts in Virtual Machine (page 112) for more information on right-
click imitation. 

Defining New Key Combinations 

Each key combination should include at least one special key (Ctrl, Option(Alt) and 
Shift). 

To define a new key combination, do the following: 

1 Select check boxes of one or more special keys. 

2 If you want to add an ordinary key: 

 select the Custom check box,  

 place input focus in the field for an ordinary key (the extreme right field),  

 then press the key you want to use on your keyboard.  
 

Using Virtual and Real Disks 
In this section all types of disks handled by Parallels Desktop virtual machines are discussed. 
 

Hard Disk Images 

File Type 

The current version of the Parallels Desktop creates and uses only virtual hard disks stored in 
.hdd files. The size of a virtual disk can be set within the range of 20 MB to 128 GB. Physical 
hard disks are are not able to be used. 
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Format of the Virtual Disk 

A virtual hard disk can be one of two formats: plain or expanding.  

plain A disk of this format occupies all of the allocated space from the moment it is 
created. It takes more space on the real hard disk and more time to create as 
compared to an expanding virtual hard disk, but allows the guest OS to operate 
faster. 

expanding A disk of this format is small initially and grows as you add applications and 
data to the Virtual Machine. The disk size you enter when creating the disk is 
the maximum size to which the disk can grow. When you just begin to operate 
with the disk, it's size is much less than this value. 

Expanding disks take less time to create and save disk space. 

Disk format is set when you create a hard disk image. If you need to change the disk format 
after the hard disk file is created, a copy of the disk in another format can be made using the 
Parallels Image Tool (page 164).   

Hard disk images of both formats are stored in .hdd files, however the structure of a disk file is 
different. Format of the virtual hard disk is displayed in the Disk format field on the Advanced 
(page 90) tab of Hard Disk Options.  

If you discover that a hard disk's size is insufficient, you may increase disk capacity using the 
Parallels Image Tool (page 164). 

Creating New Virtual Hard Disk 

A new virtual hard disk can be created at the same time when a virtual machine is created and 
attached to this virtual machine. For a typical virtual machine, a new hard disk is created 
automatically, as for custom virtual machines, you have to select Create a new virtual hard disk 
option in step 6 of the New Virtual Machine Wizard (page 34). 

To add a new virtual hard disk to an existing virtual machine use the Add Device Wizard. (page 
99) 

You may also replace the current virtual hard disk in an opened virtual machine configuration 
with a new one using the Recreate button on the Hard Disk Options (page 88) tab in 
Configuration Editor.  

Maintaining Virtual Hard Disks 

Virtual hard disks require periodic maintenance procedures to keep disk operations quick and 
efficient, similarly to real hard disks.  An expanding disk is very size efficient at the beginning 
of a virtual machine's life cycle and becomes less and less efficient as time goes on, because 
each time writing to the disk is requested, the system allocates new space, and therefore disk 
size increases. Deleting files does not reduce the size of a virtual disk image file in the primary 
operating system. Eventually, an expanding virtual disk could grow enormously causing a 
number of inconveniencies.  
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Parallels Desktop includes two tools to serve both of the purposes described above: 

 Parallels Compressor, a powerful tool that effectively cleans up virtual hard disks (not only 
expanding disks but plain ones as well) allowing the user to select a level of cleaning and 
additional operations to perform. Currently Parallels Compressor can process virtual hard 
disks of the following guest operating systems:  
 Windows XP Professional Edition SP2,  

 Windows XP Home Edition SP2,  

 Windows 2000 Professional SP4. 

For information on Parallels Compressor refer to the Running Parallels Compressor (page 
144) chapter. 

 Disk Compacting Tool which is recommend for all other guest operating systems. For more 
information on the Disk Compacting Tool refer to the Compacting Virtual Disk (page 140) 
topic. 

 

Floppy Disk Images 
Parallels Desktop can create and use floppy disk image files that appear to virtual machine 
floppy drive as real diskettes. Floppy disk images created by Parallels Desktop have the .fdd 
format. Blank .fdd image can be created by two methods: 

 using the Recreate button on the Floppy Options (page 87) tab of the Configuration Editor,  
 when adding a floppy drive to a virtual machine use the Add Hardware Wizard (page 99). 

If you use Parallels Workstation for Windows and Linux, you may create an .fdd image of a 
real diskette using the Parallels Image Tool (page 164), then transfer this image file to the Mac 
and connect it to a Parallels Desktop virtual machine. 

You may also use .img and .ima floppy images created by WinImage or VMware 
applications.  
 

CD/DVD Real Discs and Images 
Parallels Desktop can access real CD/DVD discs, or create and use CD/DVD images files that 
appear to the CD/DVD-ROM drive of a virtual machine as a real disc. Parallels Desktop uses 
CD/DVD discs in .iso format. Images in this format can be created by many applications, 
particularly by Parallels Image Tool (page 164), a special tool for creating images of different 
real media that is installed along with Parallels Desktop. 

There is a set of limitations on using CD/DVD-ROMs in Parallels Desktop in that it allows the 
use of only a single-session CD or DVD-ROM. Multisession disks cannot be handled. Sound 
from audio CDs cannot be reproduced. Neither CD nor DVD discs can be written. 
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Selecting and Opening a Virtual 
Machine 

When you launch Parallels Desktop, the last used virtual machine is opened by default. This 
option is controlled by the Load recently used VM at startup setting on the Common tab (page 
68) of the Preferences window. You may turn this option off, to start Parallels Desktop with the 
Startup Options dialog, which is discussed in the separate topic Startup Options Dialog (page 
79), or with blank virtual machine. In these cases the last used virtual machine can be opened 
via the recently used list. 

There are other ways to open virtual machines as well: 

 List of recently used virtual machines; 
 Browsing the hard disk for a configuration; 
 Open a virtual machine in a new window. 

Opening Recently Used Virtual Machines 

The Open Recent list in the File menu displays the names of the six most recently used virtual 
machines. Use this method to open a virtual machine you recently worked with.  

If the required virtual machine is not shown in the recently used list, you may find it browsing 
the hard disk for its configuration file manually. 

 
 

Browsing Hard Disk for a Configuration 

To select a virtual machine that is not represented in the recently used list, you should perform 
the following operations: 

1 Click the  icon on the Command Button panel at the bottom of the 
Parallel Desktop window or select Open in the File menu.  

2 Browse for a desired configuration file and click OK. After the configuration file is opened, 
its file name appears in the Parallels Desktop title bar; virtual machine name and full 
configuration file name with path are displayed on the property page (page 63).  
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Opening a Virtual Machine in a New Window 

You may open an additional instance of Parallels Desktop using the menu. To do this: 

 Select the New Window command in the File menu. 

Since the last used virtual machine is blocked by the Parallels Desktop instance where you issue 
this command, a new window is opened either with the Startup Options (page 79) dialog (if the 
Show startup dialog option is selected on in the Common tab of the Preferences window), or 
with a blank virtual machine. 
 

Startup Options Dialog 
This dialog is sometimes displayed upon Parallels Desktop startup in order to assist in easily 
opening a Virtual Machine or proceeding to creation of a new one. The first time you launch 
Parallels Desktop this dialog is opened automatically. 

 

Opening Recently Used Virtual Machines 

To open one of the recently used virtual machines: 

1 Select the name of the machine in the Recently Used Virtual Machines list. The VM Path will 
show the respective configuration file. 

2 Click Open.  

The list of the recently used virtual machines is empty if you launch Parallels Desktop for the 
first time. 

 



 Managing Virtual Machines 80 
 

Browsing Hard Disk for a Configuration 

To open an existing virtual machine that is not in the recently used list: 

 Click Browse button and locate the desired configuration file.  

Creating a New Virtual Machine 

To create new virtual machine: 

 Click the New VM button and follow the New Virtual Machine Wizard (page 27). 

Also, you may close this dialog by clicking the Cancel button; a blank virtual machine will be 
opened and you may start creating a new virtual machine manually. 

What to Open on Parallels Desktop Startup 

The Load recently used VM at startup and Show startup dialog options control what happens 
when Parallels Desktop is started. The same options are in the Common tab (page 68) of 
Preferences window and are described in the respective topic. Whenever you check/uncheck 
these options in one of these screens, they are automatically changed in the second one. 
 

Editing Virtual Machine 
Configuration 

Configuration of an existing virtual machine can be changed in the Configuration Editor. In this 
section we consider editing settings of devices already included in the configuration and general 
virtual machine settings. Adding and removing devices are discussed in a separate section, 
Adding New Devices to Virtual Machine. (page 99)  

Changing Device Settings 

To change device settings: 

1 Open the Virtual Machine (page 78) you wish to make changes to. 

2 Display the Configuration Editor. You are able to display it either by clicking the 

 button on the Command Button panel, by selecting Edit Configuration 
in the File menu, or by just clicking the device name in the Resource Name list. 

3 Choose the hardware whose parameters you want to alter in the left part of the 
Configuration Editor window. (Options resource contains general virtual machine settings.) 
Tabs corresponding to the selected resource are displayed. 

Note: To be able to connect any virtual device to a real one, you should have system privileges 
to access the real device. Otherwise the real device will not appear in the list of available 
devices despite it being installed on your computer.  
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Saving Virtual Machine Configuration 

After you have changed devices settings and are satisfied with them, save the virtual machine 
configuration: 

1 Click OK on the Configuration Editor screen, then click the  button on 
the Command Button panel or select Save in the File menu. The file will be saved in its 
current location with the current name. 

2 To save the configuration in another location or with another name select Save As in the File 
menu. After you have saved the file, its new file name appears in the title bar; itsl new name 
with path appears on the property page (page 63). 

 

General Options 
Under Options general virtual machine settings are collected. 

 

VM Identification: 

 Virtual machine name field shows the name of the machine that has been specified when 
creating and can be changed. Its name should be descriptive, and its length should be no 
more than 50 symbols. The name of the virtual machine is displayed on its property page 
(page 63). 
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Guest OS Type: 

 Here you can specify an operating system to be installed on the virtual machine (if you 
didn't choose the right one while creating the machine or want to install another OS). Be 
careful to choose the right operating system. If settings on this tab do not correspond with 
the operating system actually installed this may cause problems varying from slow 
performance to machine failure. 

 

Booting Options 

 

On the Booting Options tab you can select the order of devices from which the virtual machine 
will try to boot one-by-one. You can choose one of the three predefined sequences - [Floppy, 
Hard drive, CD-ROM], [Hard drive, Floppy, CD-ROM], [CD-ROM, Hard drive, Floppy]. During its 
startup, the virtual machine checks media in the first device of the boot sequence and tries to 
boot from it. If the media is not found or is not bootable, the virtual machine will proceed with 
the next device in the boot sequence, and so on.  

Note: Please make sure that a boot disk (Floppy disk, Hard Disk, CD-ROM) is available and 
configured correctly. If you select a boot disk that does not exist, after starting up the guest 
operating system and loading BIOS, you will see the error message “Currently opened 
virtual machine does not include any boot devices. In order to 
be successfully booted the virtual machine should have at least 
one of the following devices attached: floppy disk drive, hard 
disk drive, CD/DVD-ROM drive. Do you want to power on this 
virtual machine anyway?”. Click No, correct the configuration of your floppy or the 
corresponding IDE drive and try to start again. 
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VM Flags 

 

VM Flags tab contains various options that influence the performance of the virtual machine and 
startup configuration options. 

Emulation flags: 

 Acceleration level. Acceleration enables a number of the guest OS specific performance 
optimization techniques. We recommend selecting the High level. If you notice incorrect 
guest operating system behavior while running with high acceleration, for example when 
installing software, shut down the OS and lower acceleration level. Note that without 
acceleration at all (Disabled level) the virtual machine runs very slowly. We recommend 
turning acceleration on after finishing the process that caused problems. 

 Enable Intel VT-x Support option is available for editing if you have an Intel processor with 
Virtualization Technology on your host computer. By default VT-x support is enabled. See 
Intel Virtualization Technology (VT-x) Support (page 6) to learn about VT-x support in 
Parallels Desktop. If you are running a guest OS with VT-x support, it is indicated in the 
About Parallels Desktop screen (see the More Information (page 116) section). 

Misc flags: 

 PC speaker support enabled. If this option is enabled the virtual machine can indicate its 
actions by PC speaker sounds. 

 Autostart VM when configuration is loaded. After you open the virtual machine configuration 
file, the VM will be automatically started. 

 Switch to fullscreen mode automatically. As soon as the virtual machine is started, it will run 
in fullscreen mode. 
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Shared Folders 
Note. This tab is active in Windows 2000/XP/2003 guest OSes only. In other guest OSes you 
will see the message: "Feature is not available for this type of guest 
operating system". 

 

 Enable shared folder option allows/prohibits using shared folders in the virtual machine. 
 The list below displays all the shared folders created for this virtual machine. The Name 

column shows name of the folder in the guest OS, the Path column shows the same folder in 
the file system of your Mac. 

 Add button  opens the Shared Folder Properties dialog for creating a new shared folder. 
See the Using Shared Folders (page 105) section for detailed description of this process. 

 Delete button  removes the selected shared folder. 

 Edit button  opens the Shared Folder Properties dialog where you can make changes in 
the shared folder properties. See the description of this dialog in the Using Shared Folders 
(page 105) section. 
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Video (Screen Resolutions) 

 

 Enable custom screen resolutions option allows/prohibits using different screen resolutions 
for the virtual machine. 

 Screen Resolutions table displays all the custom resolutions defined for this virtual machine. 
The check mark near a resolution means that this resolution will be available for selection in 
the virtual machine. Those resolutions that are not checked will not be available for 
selection. To enable/disable a resolution, open its properties using the Edit button. 

 Add button  opens the Resolution Properties dialog for creating a new resolution. See 
the Using Custom Screen Resolutions (page 108) topic for detailed description of this 
process. 

 Delete button  removes the selected screen resolution. 

 Edit button  opens the Resolution Properties dialog where you can make changes in the 
screen resolution properties. See description of this dialog in the Using Custom Screen 
Resolutions (page 108) section. 
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Memory Options 

 

The Memory Size parameter describes the size of virtual memory (RAM) to be allocated for the 
virtual machine. You can choose any value from 4 to 1500 MB. We advise you not to exceed 
the recommended maximum because this is the limit of the physical RAM that your system 
should reserve for virtual machines. If this amount is not enough the redundant memory is 
swapped to disk, thus slowing down both guest OS and primary OS performance.  

The recommended memory maximum size is specified on the tab below the slider. This value 
can be adjusted on the Memory tab (page 70) in the Preferences window. 

To set memory size for the current virtual machine use slider, spin buttons in the RAM field, or 
type a value directly into the field. Memory size should be set at a multiple of 4. If not, when 
trying to save memory options you will receive an error message.  
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Floppy Options 
A virtual machine floppy drive can be connected to a floppy disk image. To get information on 
floppy disk images used by Parallels Desktop read the Floppy Disk Images (page 77) topic.  

 

Device status: 

 To temporary disable floppy drive operations without deleting it from configuration, 
deselect Enabled check box. 

Note: If you start the virtual machine with the floppy drive disabled, you cannot change this 
option when virtual machine is running.  

If the floppy drive is enabled, it can be connected/disconnected while VM is running. Media 
that the floppy drive accesses can also be changed. 

 To start guest OS with the floppy disk inserted, select the Connect at startup check box. 

Emulation: 

 To connect the virtual floppy drive to a floppy disk image, specify the name of the floppy 
disk image in the Image File field. You may use Browse button to locate the file.  

 Parallels Desktop allows to create a blank floppy image. Type the file name and the path in 
the Image File field and click the Recreate button. The size of a floppy disk image equals 
1.44 MB. The default extension for a floppy disk is .fdd. 
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Hard Disk Options 
The current version of Parallels Desktop allows virtual machines to only use hard disk images in 
.hdd format. Read the Hard Disk Images (page 75) topic to get acquainted with disk format 
and its other options. 

Up to four IDE devices (hard disks and CD/DVD-ROM drives) can be connected to a virtual 
machine currently. This means, that there can be no more than four hard drives plus CD/DVD-
ROM drives, i.e., it doesn't matter how many of IDE devices are hard drives and how many are 
CD/DVD-ROMs. 

 

Device status: 

 To temporarily disable operations with this hard drive without deleting it from 
configuration, deselect Enabled check box. 

Emulation: 

 If you want to change the hard drive connected to your virtual machine, you may choose 
another .hdd file in the Image File field.  

 Recreate button deletes an old hard disk and creates a new one. Use this opportunity if you 
want to create a disk from scratch. If you want to replace the current hard disk with a new 
one do the following: 

1 Click the Recreate button. 
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2 Create HDD window appears. You can specify Disk size and whether the disk should be 
expanding (page 76) or plain (page 76). Select Expanding disk check box if you want the 
hard disk to be expanding.  

 
3 Click Create. 

4 You are asked to confirm that you are going to create a new disk instead of the old one. 
Click Yes. A new empty disk is now connected to your virtual machine. 

Note: If while using a hard disk you discover that its size is insufficient, you may increase disk 
capacity using the Parallels Image Tool (page 164). 
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Advanced 

 

Device Geometry: 

 Fields Cylinders, Heads, and Sectors in this group show geometry of a virtual HDD. Note 
that the geometry concerns virtual disk, not a real one where virtual disk is stored. 

 Disk format label indicates virtual hard disk format. See the Format of The Virtual Disk 
(page 76) in the Hard Disk Images topic.  

Attachment Options: 

 Choose the IDE slot to connect to the HDD image in the Connect to field. If you want the 
HDD to be startup one select IDE 0:0.  

Note that if you set two startup drives at once - hard disk (IDE 0:0) and CD/DVD-ROM 
(IDE 0:1) - the guest OS will try to boot according to the sequence set on the Booting 
Options (page 82) tab under the General Options. 

Optimization: 

 If the selected disk is an expanding-type disk, the Compact button starts the process of 
compacting the disk. See the Compacting Virtual Disk (page 140) topic for information on 
this feature. The Compact button is disabled for plain virtual disks. 
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CD/DVD-ROM Options 
A virtual machine CD/DVD-ROM drive can be connected to a real CD/DVD-ROM drive of 
your computer as well as to a CD/DVD .iso image. To get information on using CD/DVD 
images in Parallels Desktop look in CD/DVD Real Discs and Images (page 77) topic.  

Up to four IDE devices (hard disks and CD/DVD-ROM drives) can be connected to a Virtual 
Machine currently. This means, that there can be no more than four hard drives plus CD/DVD-
ROM drives, i.e., it doesn't matter how many of IDE devices are hard drives and how many are 
CD/DVD-ROMs. 

 

Device Status: 

 If you wish to temporary disable a CD/DVD-ROM drive without deleting it from 
configuration, deselect Enabled check box.  

Note: If you start the operating system with the CD/DVD-ROM drive disabled, you cannot 
change this option when virtual machine is running.  

If the CD-DVD-ROM drive is enabled, it can be connected/disconnected while VM is 
running. Media that the CD/DVD-ROM drive can access may also be changed. 

 If the CD/DVD-ROM drive is enabled, you can select the Connect at startup check box to 
start the guest OS with the CD/DVD disc inserted. 
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Emulation: 

 If you have a physical CD/DVD-ROM on your computer, you can use it in the virtual 
machine. In this case, select the Use real CD/DVD-ROM check box, the name of the physical 
CD/DVD-ROM (for example, D:) will be shown in the CD/DVD-ROM drives drop-down 
menu and available for selection. 

Note: To be able to connect the virtual machine CD/DVD-ROM drive to a real CD/DVD-
ROM drive, you should have system privileges to access the real device. Otherwise the real 
CD/DVD-ROM drive will not appear in the list of available devices even though it is 
installed on your computer.  

 If you want to use a CD/DVD image (e.g., the .iso file), select the Use image file flag. As 
you select it, another field where you can enter the CD/DVD image file name appears 
below. Specify the path to your CD/DVD image file or click the Browse button and locate 
the CD/DVD image file.  

Attachment Options: 

 Choose the IDE slot to connect to CD/DVD-ROM image in the Connect to list. If you want 
the CD/DVD-ROM to be the startup drive select IDE 0:1 in the list. 

Note that if you set two startup drives at once - hard disk (IDE 0:0) and CD/DVD-ROM 
(IDE 0:1) - the guest OS will try to boot according to the sequence set on the Booting 
Options (page 82) tab of the General Options. 
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Network Adapter Options 
In the current version of Parallels Desktop a RTL8029 (NE2000 compatible PCI card) network 
adapter is supported. 

In a Linux guest OS, to be able to access an external network in the virtual machine, a ne2k-pci 
driver should be loaded into the Linux kernel. It is included by default, however if you are going 
to recompile the kernel remember to select the ne2k-pci component. In a FreeBSD guest OS you 
need to have the if_ed.ko module loaded. 

 

Device Status:  

 If you wish to temporarily disable network support in the Virtual Machine without deleting 
the network adapter from configuration, deselect the Enabled check box. When the Enabled 
check box is selected, the options and fields for configuring the network become active. 

 If network adapter is enabled, you can select Connect at startup check box to start the guest 
OS with network adapter connected. 

Emulation: 

In the Emulation group, you can select the type of network adapter to be used in your guest OS. 
You can choose between the Bridged Ethernet and Host-only networking. 

 Bridged Ethernet networking is intended to access local network and Internet using physical 
Ethernet adapter of your computer. A virtual machine is treated as a separate computer and 
should be configured the same way as a real one.  
If you select the Bridged Ethernet radio button, the drop-down list below will show a list of 
all physical network adapters available on your computer. Choose one of them to connect to 
your virtual adapter.  
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 Select Host-only networking if you want to emulate a network inside your computer, you 
don't want to access a network outside your local computer, or you don't have a physical 
network interface card. When you set this option, the primary OS and other Parallels 
Desktop virtual machines inside it are visible, thus making it possible to imitate a network 
that includes the primary OS and a number of virtual machines. The Creating Host-Only 
Network (page 103) topic discusses how to configure a host-only network. 

Advanced 

 

 This tab allows you to specify a network driver to be used in your guest OS. In the current 
version of Parallels Desktop a RTL8029 driver for the Ethernet adapter is supported. It is 
already selected in the Type field.  
You can find native Realtek RTL8029 drivers for many different guest OSes in the Parallels 
Tools (page 48) pack shipped together with the Parallels Desktop. 

In Windows 2000/XP/2003 guest operating systems you can improve network performance 
by installing a specially developed PRLETH driver that can be found in the Parallels Tools 
pack. 

 A MAC address is generated automatically but can be changed manually. If you decide to 
change it, please make sure that the number is unique inside your network. 
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Serial Port Options 
Parallels Desktop allows up to four serial ports to be connected to a virtual machine. 

 

Device status: 

 If you wish to temporarily disable operations with a serial port without deleting it from 
configuration, deselect the Enabled check box.  

Note: If you start the operating system with the serial port disabled, it can not be 
connected/disconnected while the VM is running. 

 If you have enabled the port, you can select the Connect at startup check box to start the 
guest OS with this port connected.  

Emulation: 

Parallels Desktop suggests two methods of serial port emulation:  

 using socket technology (Use socket option). 
If you have selected Use socket, the Socket Name field appears containing a default socket 
name. Use it or type a new name that should subject to the following rules. The name should 
begin with /tmp/, i.e. it should be in the form /tmp/<socket>. If a name doesn't 
subject to the rule, then after virtual machine is started you will get the error message: "Com 
Port <number>: Unable to open <port name> device". 

In the second field select a role at this end of the socket. 
 using an output file (Use output file option). 

You can attach the existing file using the Browse button or create a new one. The new file is 
created in the virtual machine directory. 
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Parallel Port Options 
Parallels Desktop allows up to three parallel ports to be connected to a virtual machine. 

 

Device status: 

 If you wish to temporarily disable operations with a parallel port without deleting it from 
configuration, deselect the Enabled check box. If the parallel port is enabled, it can be 
connected/disconnected while the VM is running. 

Note: If you start the operating system with the parallel port disabled, you cannot change 
this option when the virtual machine is running.  

 If you have enabled a port, you can select the Connect at startup check box to start the guest 
OS with this port connected.  

Emulation: 

The current version of Parallels Desktop suggests only one method of parallel port emulation:  

 using an output file (Use output file option). 
You can attach the existing file using the Browse button or create a new one. The new file is 
created in the virtual machine directory. 
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Sound Options 

 

Parallels Desktop virtualizes the Realtek AC'97 compatible sound card. 

Device status: 

 Enable option allows/prohibits using the sound device in the virtual machine. If the sound 
device is enabled, it can be connected/disconnected while the VM is running. However if 
you wish to temporarily disable operations with a sound device without deleting it from 
configuration, deselect the Enabled check box.  

Note: If you start the operating system with the sound device disabled, you cannot change 
this option when the virtual machine is running.  

 To start the guest OS with the sound device activated, select the Activate sound at startup 
check box. 

Emulation: 

 After the sound is enabled, the Output Device field appears containing a list with the 
Default Audio and Null Device items. As a rule we recommend to select the 
Default Audio device. Null Device is the choice for situations when you don't want 
to produce sound while the sound card is required by the guest OS'es applications.  

 The same situation occurs with the Mixer Device. As a rule we recommend to select the 
Default Audio device. Null Device is the choice for situations when you don't want 
to produce sound while the sound card is required by the guest OS'es applications.  

Note.  If you are not satisfied with the quality of sound produced, a special AC'97 sound 
driver (page 49) is available for Windows 95/98/ME/NT/2000 guest OSes and for OS/2 and 
eComStation guest OSes. You can install it instead of standard one. 
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USB Options 

 

Device status: 

 Enable option allows/prohibits using USB devices in the virtual machine. If the USB is 
enabled, USB devices can be connected/disconnected to the virtual machine while it is 
running. However if you wish to temporarily disable USB operations without deleting it 
from configuration, deselect the Enabled check box.  

Note: If you start the operating system with the USB disabled, you cannot change this 
option when the virtual machine is running.  

Connection Options: 

 Autoconnect USB devices. Select this option if you want the running virtual machine to 
capture new USB devices connected to your host computer. New device are captured if 
there is no more than one USB device currently active. 

 

 



 Managing Virtual Machines 99 
 

Adding New Devices to Virtual 
Machines 

Virtual machine technology allows adding new devices to a virtual machine to be the same as 
connecting new devices to a real computer. Virtual machine configuration can include the 
following devices: 

 up to four IDE devices - virtual hard disks and CD/DVD-ROM drives; 
 a floppy drive; 
 a network adapter; 
 up to four serial ports; 
 up to three parallel ports; 
 a sound device; 
 a USB controller. 

New devices are added using the Add Hardware Wizard. Devices of any type (except hard disks) 
can be connected to a real drive as well as to virtual media. In addition, if you add a floppy 
drive, a new blank .fdd image can be created at the same time and connected to the drive. 
When adding a virtual hard disk you may choose between connecting an existing hard disk 
image and creating a new one. 

Note: To be able to connect any virtual device to a real one, you should have system privileges 
to access the real device. Otherwise the real device will not appear in the list of available 
devices even though it is installed on your computer.  

To add a new device to the virtual machine do the following: 

1 Open the virtual machine to which you want to add new device, then select Edit 

Configuration in the File menu or click  on the command button panel to 
open Configuration Editor. 

2 In the lower left part of the Configuration Editor window click the Add button. 
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3 The Add Hardware Wizard greets you with the Welcome to Add Hardware Wizard screen. 
Click Next. 
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4 On the Select hardware screen you should choose the device you want to add to your 
machine. 

The Available Hardware list contains devices available for adding. If the VM configuration 
already includes the maximum allowed number of a particular device type, this device type 
will not appear in the Available Hardware list. For instance, only one floppy drive is allowed. 

The wizard allows you to add only one device at a time.  

 
On this screen you may prefer to add devices immediately without specifying its options, in 
order to save time (You may set options later in the Configuration Editor). To do so, click 
the Add Instantly button after selecting the desired device. The new device is added 
immediately with standard options, and some of them are not set at all (for example, the 
instant hard disk has a size of zero).  

To set the options of the device being added click the Next button. 

5 Follow the wizard screens to configure the new device. You should select the device type, 
the media it is connected to, and the options specific to the device and media type. All of 
them are described under the Editing Virtual Machine Configuration (page 80) section. The 
final options screen contains the Finish button.  
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Removing Devices 
Most virtual machine devices can be removed from the configuration. Memory and those 
elements of the virtual machine configuration that are not devices but rather collections of 
settings can not be removed. These elements are: Options, Shared Folders, and Video.  

Note. Any device, except memory, can be disabled in the Configuration Editor (page 80) 
without removing it from configuration. Uncheck the Enabled check box of the desired device.  

To remove a device: 

1 Open the virtual machine from which you want to remove a device, then open the 
Configuration Editor by selecting File->Edit Configuration in the menu or click 

  on the command button panel.  

2 Select the device you want to delete in the left part of the Configuration Editor window. Note 
that options, shared folders, video, and memory list entries can not be deleted.  

3 Click the Remove button. 
 

Networking in a Virtual Machine 
In general, Parallels Desktop allows two types of networking in virtual machine, Bridged 
Ethernet and Host-only networking. However in some cases you may prefer a mixed mode, 
Host-Only with Internet Sharing (NAT). This section describes these types of networking and 
ways of configuring them. 
 

Bridged Ethernet Networking 
 Bridged Ethernet networking allows virtual machines to access a physical network, such as a 
Local Area Network and/or Internet. You should have an Ethernet adapter installed on your host 
computer.  

To access a LAN and Internet, configure the virtual machine: 

 in virtual machine Network Adapter Options (page 93) select Bridged Ethernet type of 
networking in the Emulation group and choose the proper network adapter in the list, 

 configure network options in the guest operating system.  

If you encounter problems when using Bridged Ethernet mode or you do not want to use 
Bridged Ethernet networking because of security considerations, consider Host-Only 
Networking with Internet Sharing (page 104). 
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Creating a Host-Only Network 
Parallels Desktop provides a virtual network accessible only to the primary operating system 
and virtual machines running on it. The primary operating system is attached to this network 
through the Parallels Host-Guest Virtual NIC adapter installed along with Parallels Desktop. For 
a virtual machine to join a host-only network, the guest network adapter should be set to host-
only networking. IP addresses for the primary operating system and virtual machines may be: 

 dynamic (assigned by Parallels DHCP server running on host-only network); 
 static (assigned manually). 

Configuring Network with Dynamic IPs 

IP addresses for machines in a host-only network are provided by Parallels DHCP server that is 
started automatically whenever you launch Parallels Desktop. DHCP server is installed along 
with Parallels Desktop. 

Configure network with dynamic IPs in the following way: 

1 Open Configuration Editor for the virtual machine and on the Network Adapter Options tab 
select the Host-only networking parameter. 

2 Select Parallels Desktop->Preferences in the menu. Specify a range of IP addresses to be 
assigned to the virtual machines on the DHCP tab.  

Configuring Network with Static IPs 

To configure host-only network with static IP addresses you have to manually assign them to 
the primary operating system and to each virtual machine in which you want to include on the 
network.  

The virtual machine should be configured as follows: 

1 Open the Configuration Editor for the virtual machine and on the Network Adapter Options 
tab select the Host-only networking parameter.  

2 Start the virtual machine and specify the IP address by standard means for the guest 
operating system installed on it.  

Configuring a static IP address for the primary operating system: 

1 Open System Preferences. 

2 In the Internet & Network section, click the Network icon. 

3 In the Network screen, select Parallels Host-Guest Adapter in the Show drop-
down list. 

4 Open the TCP/IP tab of the Network screen. 

5 In the TCP/IP tab: 

in the Configure IPv4 option select Manually, 

specify the IP Address and Subnet Mask. 

6 Click the Apply Now button and close the Network screen. 
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Host-Only Networking with Internet Sharing 
If you encounter one of the following: 

 you want to access the Internet in a virtual machine but do not want to use Bridged Ethernet 
networking because of security considerations, 

 you have problems with Bridged Ethernet mode, 
 your Mac accesses the Internet via a modem or another non-Ethernet device, 

you may prefer to use Host-Only Networking mode in a virtual machine with Internet Sharing 
(NAT) turned on in your Mac. Note that your virtual machine will not be accessible from 
outside your Mac. 

To configure this type of networking:  

1 Open the Configuration Editor for the virtual machine and on the Network Adapter Options 
tab select the Host-only networking parameter. 

2 In your Mac OS X, open System Preferences and click Sharing in the Internet & Network 
section. 
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In the Sharing screen, select Ethernet Adaptor (enX) from the To computers using list.  

Select the adapter you want sharing from in Share your connection from drop-down list. 

Click the Start button and confirm staring the service. 

 
 

Using Shared Folders 
Shared folders are folders in your Mac file system that are visible to the guest OS also. These 
folders are used for exchanging files between the primary OS and a virtual machine or between 
several virtual machines.  

In the primary OS shared folders appear as usual folders, while in guest OS they are objects of 
the network neighborhood. 

Using shared folders is possible for the following guest OSes:  

 Window 2000/XP/2003. 
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Setting Up a Shared Folder 
Setting Up a shared folder requires two steps: 

1 Adding a shared folder(s) in your virtual machine configuration.  

2 Installing Parallels Tools in your guest OS. 

See below for detailed instructions. 

Adding a Shared Folder 

1 Open the virtual machine configuration, click the  button to open the 
Configuration Editor. 

2 In the Configuration Editor, select the Shared Folders tab (see the Shared Folders (page 84) 
topic). Select the Enable shared folders option. 

3 In the Shared Folders tab, click the  button to open the Shared Folder Properties screen. 

4 In the Shared Folder Properties screen: 

specify a name for the folder which will appear in your guest OS in the Name field; 

specify a folder in your Mac OS X file system that will be shared in the Path field; 

if you want to restrict writing to this folder from inside the guest OS, select the Read Only 
check box. You will be able to save files to this folder in the primary OS only; 

make sure the Enabled check box is selected; 

and click OK. 

 
5 Click OK in the Configuration Editor. 

6 Click  to save the virtual machine configuration. 
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If you have not installed the Parallels Tools in a virtual machine, proceed to the Installing 
Parallels Tools in the Guest OS subtopic. If you have them installed: 

 power on your virtual machine and view shared folders in your guest OS. 

Installing Parallels Tools in Guest OS 

Parallels Tools includes the Shared Folders tool which is necessary for a guest OS to view the 
shared folders. See a full description of this tool in the Parallels Tools Overview (page 49). 

Installation of Parallels Tools is performed just after you have created a new virtual machine 
and installed a guest OS in it. See Installing Parallels Tools (page 48) for detailed descriptions 
on how to do so in a particular guest OS. We recommend that you perform the typical 
installation, but if you perform a custom installation make sure the Shared Folders tool is 
selected. 
 

Viewing Shared Folder in Guest OS 
To view the contents of the shared folders in the guest OS: 

1 Start the virtual machine. 

2 Open Windows Explorer. 
3 In the Explorer, select My Networks Places, then select Entire Network, and find the Parallels 

Shared Folders. 

4 Click the Parallels Shared Folders to view the list of shared folders available in your virtual 
machine. 

When working with a shared folder inside a virtual machine, keep in mind that the ability to 
save files into this folder depends on its Read Only setting. 
 

Using USB Devices in a Virtual 
Machine 

The current version of Parallels Desktop emulates the 2-port USB controller 1.1. This means 
that up to two USB peripherals can be connected to a virtual machine simultaneously. Parallels 
Desktop currently supports bulk devices such as scanners, printers, mass storage, PDAs, etc. 
Isochronous devices are not supported in the current version. 

Parallels Desktop lets you connect USB devices to virtual machines automatically. See the USB 
Options (page 98) section to learn how to turn this option on. And see the Connecting USB 
Devices (page 131) section to learn how to connect a USB device to a virtual machine both 
automatically and manually.  
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Using Custom Screen Resolutions 
Parallels Desktop allows you to define up to 10 different resolutions for a virtual machine and 
change them when running the guest OS. 

You may set typical resolutions, such as 640x480, 800x600 etc., and moreover you may try to 
define non-standard ones. However we do not guarantee that your guest OS will support them.  

Adding a Screen Resolution 
1 Open the virtual machine configuration you want to add a resolution to, click the 

 button to open the Configuration Editor. 
2 In the Configuration Editor, select Video in the Resource list.   

3 In the Screen Resolutions tab (see Video (Screen Resolutions (page 85)) ), make sure the 
Enable custom screen resolutions option is selected. 

4 Click the Add button to open the Resolution Properties dialog. 

5 In the Resolution Properties dialog:  

set the desired resolution options in the Width, pixels and Height, pixels fields; 

select the Enabled check box if you want this resolution to be available for selection in the 
guest OS; 

click OK. 

 
6 Click OK in the Configuration Editor. 

7 Click  to save the virtual machine configuration. 
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Changing Screen Resolution for a Virtual Machine 

To change screen resolution: 

 Power on your virtual machine. 
 Select the preferred resolution as it is usually done in your guest OS. The guest OS will 

propose for selection all the resolutions available in the Video (Screen Resolutions) (page 
85) tab for which the Enabled option is selected. 

If you have defined a non-typical resolution and do not see it in the list of available resolutions 
in the running guest OS, this means that your guest OS can not use this resolution. 
 

Making Copy of a Virtual Machine 
A complete copy of a virtual machine can be created using the Clone Virtual Machine Wizard. A 
new configuration file and new hard disk drive(s) are made. The clone includes as many hard 
drives as there are connected to an original machine. By default the Wizard puts new files into a 
new directory, but you may prefer to store them in an existing one. Copies of virtual hard disks 
are always placed in the same folder with the copy of the configuration file. 

Auxiliary devices of the new virtual machine are connected to the same drives or disk images as 
the source devices. If source CD/DVD-ROM drive is connected to an .iso CD/DVD disc 
image file, this connection is restored in the new machine. The same goes for the floppy drive. 
However output files of serial/parallel ports, if used, are not transferred from the original VM. 
In the clone, they are started from scratch.  

If a network adapter is included in the original configuration, a new MAC address is generated 
for the new adapter.  

A virtual machine to be copied should be opened and meet the following conditions: 

 The guest OS is not running. If it is running, the menu item that starts the wizard is disabled. 
 The virtual machine is not opened by another instance of Parallels Desktop. 
 It is not a blank virtual machine. Blank virtual machines can not be copied. 

To make a clone of a virtual machine: 

1 Open the virtual machine you want to make copy of. 
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2 Select Clone VM in the VM menu. The Clone VM Wizard starts. Click Next. 
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3 In the next step, Specify new virtual machine name and location, you have to specify a name 
for the clone and a path for storing its configuration file. The name and path suggested by 
the wizard are made by adding "Clone of" at the beginning of the original virtual machine 
name and path. You can modify both of them. Remember that a virtual machine name  
should be no longer than 50 characters. 

If you select the Open virtual machine in new window automatically option, after the new 
configuration is created it will be opened in a new Parallels Desktop window. Click Finish 
to start copying the machine. 

 
If the directory for storing the virtual machine configuration file does not exist, the 
confirmation for its creation may be asked: "Directory <directory name> does 
not exist. Do you want to be created automatically?" Click Yes. A 
new directory will be created. 
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4 While the virtual machine is being copied, the Copying in progress screen indicates the 
current state of the process. If everything is OK, the Wizard informs you that copying has 
been performed and a new machine is ready. Click Exit to close the Wizard. 

 
A new instance of Parallels Desktop is opened with the new virtual machine loaded, if you 
have selected the corresponding option on the Specify new virtual machine name and location 
screen. 

 

Keyboard Shortcuts in a Virtual 
Machine 

How to Right-Click If Mouse Does Not Have the Right Key 

If your mouse does not have the right key, you are probably used to pressing Ctrl+click 
combination instead. Parallels Desktop gives you the option of using the Ctrl+click 
combination for standard selection operation and proposes two other ways to perform a right-
click in virtual machine: 

 Press a key combination plus mouse click simultaneously. 
By default Ctrl+Shift+click the mouse key is defined. You may set other keys 
on the Preferences -> Hot Keys (page 74) tab. 

 Click with delay. 
You have to click and hold the mouse button until the context menu is displayed. Preferred 
delay is specified on the slider on the Preferences -> Hot Keys (page 74) tab.  
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By default this method is disabled and is to be enabled manually on the Preferences -> Hot 
Keys (page 74) tab. 

Using Mac System Keyboard Shortcuts in a Virtual Machine 

Mac keyboards have a set of system keys, and problems may result when using these keys in a 
Virtual Machine. For instance, the F9 - F12 keys are reserved for Dashboard & Expose 
operation, whereas F11 can be handy in Windows Internet Explorer for full screen mode. To be 
able to use this Mac shortcuts with a virtual machine keyboard, do the following: 

1 In Mac OS X, open System Preferences, and click Universal Access in the System section. 
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2 In the Universal Access window select Enable access for assistive devices option. 
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About Parallels Desktop Screen 

 

The upper part of the About Parallels Desktop screen provides information on the number of the 
build you are using, the full name of the vendor and link to its site, and copyright and trademark 
information as well. 

Licensing Information 

  indicates your type of activation and to whom this copy is licensed. 

Support Information  

 contains the contact information of the Parallels technical support group. 

Buy Online and/or Evaluate buttons 

 are provided if you have a trial activation or did not activate your copy at all. If you have 
activated the program with a permanent activation key, none of these buttons will be 
displayed. See Activating Parallels Desktop (page 17) for a detailed description of the 
processes of receiving a key and activating. 
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More Info button  

 opens the screen with details of your license and set of indicators. 
 

More Information 

 

License Status: 

 User Name and Company Name contain information about your name and the name of your 
company that you entered in the Activate Product window. 

 Product ID displays the identification number of your copy of Parallels Desktop  as well as 
the following information: the version of the Parallels Desktop, license number, and the 
abilities covered by your license that are displayed in the Primary OSes and Terminal 
Services fields. 

 Validity period shows the date until your license is valid. 
 Primary OSes indicates which primary operating systems are allowed by your license. 
 Terminal Services displays which primary operating systems are able to access Parallels 

Desktop remotely. 

Note: The same license information is displayed in the Activate Product window. See 
Activating Parallels Desktop (page 17).  
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Virtual Machine Features: 

This group contains indicators that are active only when the guest OS is running. Otherwise 
they are off. 

 Virtualization mode shows Intel VT-x if you work on an Intel VT-enabled processor and 
Virtualization Technology is activated through the virtual machine configuration setting 
available on the VM Flags (page 83) tab of the General Options. See Intel Virtualization 
Technology (VT-x) Support (page 6) for a full description of VT-x. 
If you are running without Virtualization Technology, the virtualization mode indicates the 
acceleration level. All guest OSes, besides Windows NT/2000/XP/2003, run in Software 
mode 0. Windows NT/2000/XP/2003 starts with Software mode 0, then switch to 
Software mode 1 and Software mode 2 in case the Acceleration Level setting (on 
the VM Flags (page 83) tab of the General Options) is set to High.  

 Remote session indicates if Parallels Desktop is executed on a remote server. 
 

Deleting a Virtual Machine 
Virtual machines can be deleted manually, however we recommend doing it using the Delete VM 
Wizard that detects all the files that make up the virtual machine and are connected to it. 

The Wizard helps remove the following virtual machine components and associated files: 

 configuration file, 
 virtual hard disk drives connected to the virtual machine, 
 CD/DVD disc .iso images connected to the virtual machine (if any), 
 floppy disk image (.fdd  or other) connected to the virtual machine (if any), 
 output files of serial and parallel ports (if any), 
 home directory where virtual machine files are stored. 

The Wizard can delete a currently opened virtual machine that meets the following conditions: 

 Its guest OS is not running. If it is running, the menu item that starts the wizard is disabled. 
 The virtual machine is not opened by another instance of Parallels Desktop. 
 The virtual machine is not blank. 

To delete a virtual machine: 

1 Open the desired virtual machine. 
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2 Select Delete VM in VM menu. The Welcome to the Delete Virtual Machine Wizard screen is 
opened. Click Next. 
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3 The Wizard detects all files related to the virtual machine and presents them on the Review 
files to be deleted screen. Each device/file is displayed in a separate string, i.e. if two hard 
disks are connected to the virtual machine, there will be two hard disk strings on the screen. 
The full path is displayed for each component.  

The configuration file, virtual hard disk, output files of serial and parallel ports, and the 
home directory are pre-selected for deleting while connected CD-ROM .iso images and 
floppy .fdd (or other) images are not, because they can be useful for other virtual 
machines. If you do not consider them to be useful, mark them for deletion on this screen. 
Note that virtual hard disks can also be attached to other virtual machines. 

 
Review selected files, check those that should be deleted and click Finish when you are 
ready. 
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4 The virtual machine wizard removes the selected files from your hard disk. If everything is 
OK the final wizard screen will appear: 

 
The virtual machine is considered to be successfully deleted if all the selected components 
or all selected components except the home directory (if it was chosen for deleting) have 
been removed. If the home directory contains any files it will not be deleted.  

Click Exit to close the wizard. 

After the virtual machine is deleted, a blank VM is opened in the Parallels Desktop screen. The 
deleted machine disappears from the list of recently used configurations in the File menu. 
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C H A P T E R  7  

Running a Virtual Machine 

This chapter provides information on handling a virtual machine while the guest operating 
system is executed. 

 

In This Chapter 
Overview............................................................................................................................... 121 
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Overview 
 When you start a virtual machine, its console is opened and acts as the display of a real 
computer (refer to Console View (page 64)). Your next step is to capture your keyboard and 
mouse in the Virtual Machine screen; after doing so you are able to work with the Virtual 
Machine in the same way you would with a standalone computer. 

Parallels Desktop controls such as the toolbar and the menu allow you to manage Virtual 
Machine behavior when running the machine in windowed mode. You may also run the Virtual 
Machine in fullscreen mode, where Parallels Desktop controls and the primary operating system 
are not visible.  

While working in windowed mode, Parallels Desktop controls let you to do the following: 

 start, turn off, and reset the Virtual Machine, 
 switch between the Virtual Machine and your host computer, 
 suspend the Virtual Machine, 
 connect and disconnect devices, and change data types accessed by them, 
 temporarily disable separate Parallels Tools (if you have them installed), 
 expand the Virtual Machine console to fullscreen mode. 

The Configuration Editor is inaccessible while the virtual machine is running. 
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Starting a Virtual Machine 
To start a virtual machine: 

1 Start Parallels Desktop. See Start Parallels Desktop (on page 17). 

2 Open a virtual machine configuration (page 78). 

3 Do one of the following: 

 Click the Power On Virtual Machine button on the Parallels Desktop toolbar, 

 Select Power On in the VM menu. 

The virtual machine will be switched on, its console will be opened in the Parallels Desktop 
window, and you can see the boot process of the guest OS. 

Note that the Virtual Machine can be powered on only if you have a registered copy of  Parallels 
Desktop, regardless of whether it is of permanent or trial status. If your copy is not registered, 
the "This copy of Parallels Desktop is currently not active" warning 
appears. This warning displays your current activation status and prompts you to activate your 
copy of the product. Depending on whether you had previously received a trial activation key, 
warning text contains one or two links prompting you to get a trial or permanent key. See 
Activating Parallels Desktop (page 17) for a detailed description of the processes of receiving a 
key and activating. 
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Capturing and Releasing the 
Keyboard and the Mouse 

This section explains how to capture and release input devices (like your mouse and keyboard) 
inside a Virtual Machine. 

When you power on a Virtual Machine, either during installation or normal operation, you will 
need to capture the computer's input devices in the Virtual Machine to interact with it exactly as 
if you were using a standalone computer. Since each Virtual Machine is independent, it will not 
"see" the primary OS, and consequently, you will not be able to access Parallels Desktop's menu 
and toolbar from inside the Virtual Machine without manually releasing your input devices to 
the primary OS.  

To lock the keyboard and mouse in a virtual machine screen, do one of the following: 

 Point the mouse cursor to the Parallels Desktop client window and click somewhere inside 
the virtual machine screen. When the mouse is captured, it does not move out of the 
Parallels Desktop window.  

 Select Capture Input in the VM menu. 
 Press Command+I on your keyboard. 

To release the keyboard and mouse to your primary OS: 

 Press the hot key combination designated for releasing the keyboard/mouse (the default 
combination is Ctrl+Option(Alt)).  

The keyboard and mouse will be released immediately. Now you will be able to manage your 
virtual machines using the Parallels Desktop controls, manage your primary operating system, 
or capture the keyboard and the mouse in another virtual machine. 

The default hot key combination for releasing keyboard/mouse can be changed in the Hot Key 
Combinations (page 74) tab of the Preferences window.  

Note. You can free the mouse and the keyboard from the virtual machine screen without 
pressing the hot key combination if you install Parallels Tools. See the Parallels Tools Overview 
(page 49) to learn if this package is available for your guest operating system.  
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Switching a Virtual Machine to 
Fullscreen Mode 

To make working inside a Virtual Machine more comfortable, you can run a guest operating 
system in fullscreen mode. When running a Virtual Machine in fullscreen mode, the guest OS 
screen occupies the whole monitor of your computer; the primary OS and its applications as 
well as the Parallels Desktop menu, toolbar, and status bar are hidden.  

Note: You can start a virtual machine in fullscreen mode if the Switch to fullscreen mode 
automatically option is set in the VM Flags (page 83) tab of the General Options. 

If you want to switch to fullscreen while running a guest OS, do one of the following: 

 click the Fullscreen Mode  toolbar button,  
 select View -> Fullscreen in the menu, 
 press the appropriate hot key combination on your keyboard (Option(Alt)+Enter by 

default, unless you have defined other hot key). 

To return to windowed mode: 

 press any of the hot key combinations defined (Ctrl+Option(Alt) or 
Option(Alt)+Enter by default).  

Hot key combinations are defined in the Hot Key Combinations (page 74) tab of the Preferences 
window. 

You may adjust the animation that is displayed when switching to fullscreen mode and the size 
of the virtual machine window. See User Interface Preferences (page 72) for more info. 
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Shutting Down and Resetting a 
Virtual Machine 

A virtual machine can be shut down and reset in the same way as a typical computer. If a guest 
operating system is normally closed using some internal command (such as Shut Down in 
Windows), it is STRONGLY RECOMMENDED to shut down the machine this way to ensure 
safety of your data. However, if you are unable to stop the guest OS this way, you may use the 
Parallels Desktop controls. 

Mandatory Stopping a Virtual Machine 

To mandatory stop a virtual machine, do one of the following: 

 Click the Power Off Virtual Machine  button during guest OS execution. 
 Select VM -> Power Off in menu. 

The virtual machine will be stopped immediately. 

Resetting a Virtual Machine 

To reset a virtual machine, do one of the following : 

 Click the Reset Virtual Machine  button on the Parallels Desktop toolbar. 
 Select Reset in the VM menu.  
 Press Ctrl+Option(Alt)+Del while the keyboard is captured inside a virtual machine 

window. 
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Pausing Virtual Machine 
When a virtual machine is paused, the guest OS is stopped and the virtual machine process is 
removed from the CPU processes list. Guest operating system execution can be continued at any 
time. 

Pausing the guest OS is recommended if you want to leave the virtual machine for a short 
period of time. If you want to leave it for an extended period, and especially if you need to 
restart your primary OS, it is best to suspend of the VM. See Suspending/Resuming Virtual 
Machine (page 126). 

To pause a virtual machine: 

 Select Pause in the VM menu.  

When a virtual machine is in pause mode its console is darkened.  

To continue running the virtual machine do one of the following: 

 Click the Power On Virtual Machine  button on the toolbar. 
 Select Continue in the VM menu. 

 
 

Suspending/Resuming Virtual 
Machine 

The state of the running Virtual Machine, and all of its applications, can be saved in order to 
continue working with the guest OS at a later time. This is called suspending the Virtual 
Machine. When suspending, the Virtual Machine state is saved to the hard disk in a .sav file. 
After saving, you may return to the saved Virtual Machine at any time and continue running the 
guest OS from the point where you stopped. 

Suspending a Virtual Machine 

To suspend a virtual machine: 

1 During guest OS execution do one of the following: 

 Click the Suspend Virtual Machine button, 

 Select VM -> Suspend in menu. 

2 Progress of saving is displayed in the Please wait while virtual machine is suspending screen. 
When finished, the virtual machine property page is displayed. 
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Note. After the virtual machine is suspended, its configuration can not be changed. If you begin 
editing, despite the warning, the .sav file will be deleted and you will not be able to resume 
the virtual machine. 

Resuming a Suspended Virtual Machine 

To resume a suspended virtual machine: 

1 Open the virtual machine configuration in the typical way. 

2 Do one of the following: 

 Click the Power On Virtual Machine button, 

 Select VM -> Power On in menu. 

3 Wait until the guest OS state is resumed. Progress is displayed in the Please wait while virtual 
machine is resuming screen. 

After the virtual machine has been resumed, its .sav file is deleted. 
 

Connecting Devices When Running 
a Virtual Machine 

Despite the fact that Configuration Editor (page 80) cannot be accessed while a virtual machine 
is running, you can connect and disconnect additional devices and even choose the media type 
they access. The following virtual devices can be connected/disconnected to the running virtual 
machine: 

 CD/DVD-ROMs; 
 Floppy drive; 
 Network adapter; 
 Parallel ports; 
 Serial ports; 
 Sound device; 
 USB device. 

To connect/disconnect any device, it should be enabled in the Virtual Machine configuration. If 
you have disabled some device, you should stop the Virtual Machine first, then enable the 
device in the Configuration Editor. After that you may restart the Virtual Machine; the device 
can be connected/disconnected in a runtime environment.  

Additionally, you can change the type of media the CD/DVD-ROM and floppy drives access. 

USB Devices  

If you start the Virtual Machine with the USB controller enabled, you may connect various real 
USB peripherals to the Virtual Machine. The USB controller itself can not be connected or 
disconnected. 
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Connecting a CD/DVD-ROM Drive 
If you start a guest operating system with the CD/DVD-ROM drive enabled you can 
connect/disconnect it and change the media it accesses while running the guest OS. 

Note: If the guest OS was started with the CD/DVD-ROM drive disabled, you should shut down 
the guest OS first, then enable CD/DVD-ROM in the Configuration Editor (select the Enabled 
check box in the CD/DVD-ROM Options (page 91) tab) and restart the guest OS. 

All commands to control the CD/DVD-ROM during guest OS execution can be found in the 
Parallels Desktop Devices menu.  

If you have several CD/DVD-ROM drives connected to your virtual machine, in the Devices 
menu they are numbered according the order of their appearance. The first CD/DVD-ROM will 
be CD/DVD-ROM 1, the second will be CD/DVD-ROM 2, and so on. 

To disable all CD/DVD-ROM operations while running the guest OS click CD/DVD-ROM --> 
Disconnect in the Parallels Desktop Devices menu. 

To reconnect the CD/DVD-ROM again select CD/DVD-ROM --> Connect command in the 
Devices menu. 

Data type accessed by the CD/DVD-ROM drive can be switched from a real CD/DVD-ROM to 
an image file and vice versa. Use CD/DVD-ROM --> Connect to and CD/DVD-ROM --> Connect 
image commands of the Parallels Desktop Devices menu.  

Note: There is another way to perform all the actions described above. Right-click the 
CD/DVD-ROM icon  on the status bar (page 65) to display the CD/DVD-ROM context menu 
and select the appropriate command. 
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Connecting a Floppy Drive 
If you start a guest operating system with the floppy drive enabled, you may connect/disconnect 
it and change its options while running the guest OS. Parallels Desktop allows you to 
connect/disconnect the floppy drive and change the media the floppy drive accesses. 

Note: If the guest OS is started with the floppy drive disabled, you should shut down the guest 
OS first, then enable the floppy in the Configuration Editor (select the Enabled check box in the 
Floppy Options (page 87) tab) and restart the guest OS. 

To connect or disconnect the floppy drive to/from a virtual machine: 

 Select Floppy --> Connect or Floppy --> Disconnect in the Devices menu. 

To change the image file accessed by the virtual floppy: 

 Use Floppy --> Connect image command in the Devices menu.  

Note: There is another way to perform all the actions described above. Right-click the floppy 
drive icon  on the status bar (page 65) to display the floppy drive context menu and select the 
appropriate command. 
 

Connecting a Network Adapter 
If a network adapter is enabled in your virtual machine configuration, you can 
connect/disconnect it when running the guest OS. 

Note: If the guest OS is started with the network adapter disabled, you should shut down the 
guest OS first, then enable the network adapter in the Configuration Editor (select the Enabled 
check box in the Network Adapter Options (page 93) tab) and restart the guest OS. 

To connect or disconnect the network adapter, do the following: 

 select the Parallels Desktop Devices menu,  
 select the Network menu item, 
 then select the Connect/Disconnect command to connect or disconnect network adapter 

respectively. 

Note: There is another way to connect/disconnect the network adapter. Right-click the network 
adapter icon  on the status bar (page 65) to display the context menu and select the 
appropriate command. 
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Connecting Serial/Parallel Ports 
If a parallel/serial port is enabled in your Virtual Machine configuration, you can 
connect/disconnect the port while running the guest OS. 

Note: If the guest OS is started with the parallel/serial port disabled, you should shut down the 
guest OS first, then enable the serial or parallel port in the Configuration Editor (select the 
Enabled check box in the Serial Port Options (page 95) tab or Parallel Port Options (page 96) 
tab) and restart the guest OS. 

To connect or disconnect the serial or parallel port, do the following: 

 select the Parallels Desktop Devices menu,  
 select COM (from 1 to 4 depending on how many serial ports are enabled) or LPT (from 1 to 

3 depending on how many parallel ports are enabled), 
 then select the Connect/Disconnect command. 

Note: There is another way to connect/disconnect the port. Right-click the serial ( ) or parallel 
( ) port icon on the status bar (page 65) to display the context menu, and select the appropriate 
command. 
 

Connecting a Sound Device 
If a parallel/serial port is enabled in your Virtual Machine configuration, you can 
connect/disconnect the port while running the guest OS. 

Note: If the guest OS is started with the sound device disabled, you should shut down the guest 
OS first, then enable the sound device in the Configuration Editor (select the Enabled check box 
in the Sound Options (page 97) tab) and restart the guest OS. 

To connect or disconnect the sound device, you should do the following: 

 select Devices in the Parallels Desktop menu,  
 select the Sound menu item,  
 select Activate to connect the sound device (or select Mute to disconnect). 

Note: There is another way to connect/disconnect the sound device. Right-click the sound 
device icon  on the status bar (page 65) to display the context menu and select the appropriate 
command. 
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Connecting USB Devices 
If the USB controller is enabled in the virtual machine configuration, you can 
connect/disconnect USB peripherals to the running virtual machine. Up to two USB devices can 
be used by a virtual machine simultaneously.  

Parallels Desktop automatically detects all the USB devices connected to your host computer 
and displays them under the Devices->USB menu item and in the context menu for the USB 
controller ( ) in the status bar. Those devices that are currently connected to the virtual 
machine are checked. The primary OS can not access a USB device while it is being used by the 
Virtual Machine. 

Note: If the guest OS is started with the USB controller disabled, you should shut down the 
guest OS first, then enable the USB controller in the Configuration Editor (select the Enabled 
check box in the USB Options (page 98) tab) and restart the guest OS. 

Autoconnect 

If the Autoconnect USB devices option in the USB Options (page 98) tab is turned on and no 
more than one USB device is currently active, you can connect an additional USB device to 
your virtual machine. Do the following: 

 simply connect a USB device to your host computer.  

If you connect an additional USB peripheral to your host computer while there are two active 
USB devices already running, nothing will happen. However you are able to activate the newly 
connected device manually after deactivating any of the currently active USB devices. See the 
next subtopic to learn more on this. 

Manual Connect 

To connect a USB device to the virtual machine: 

 Connect a USB device to your host computer. 
 Select Devices->USB in the Parallels Desktop menu or context menu for the USB controller  

( ) in the status bar to display the list of all of the USB devices connected to your host 
computer. 

In the USB device list, make sure that no more than one USB device is currently active. If there 
are two devices checked, disconnect one of them by clicking it. 

 Click the desired USB device in the list to connect it. 
 

 



 Running a Virtual Machine 132 
 

Parallels Tools Center 
Note. Parallels Tools Center is available in Windows guest OSes only. 

Parallels Desktop allows you to control the status of Parallels Tools in all of the Windows guest 
OSes for which tools are provided (see Parallels Tools Overview (page 49) for tools 
descriptions and availability table). The Parallels Tools Center, which is installed along with 
Parallels Tools, allows you to: 

 check the status of various tools; 
 temporarily disable and enable each tool separately (for those tools that can be stopped 

without violating guest OS execution); 
 configure specific tool parameters (for those tools that have them). 

The Parallels Tools Center is organized as a collection of tabs, each of which contains settings 
for an individual tool. In each guest OS, the Parallels Tools Center contains tabs only for those 
tools that you have installed in your guest OS. 

Parallels Tools Center is started automatically upon guest OS startup; its icon is placed into the 
guest OS system tray. 

To open Parallels Tools Center:

 click its icon  in the guest OS system tray. 

To restart Parallels Tools Center after disabling:

 Locate the ParallelsToolsCenter.exe file in the folder where you have installed 
Parallels Tools and launch it. 
If you installed Parallels Tools into the default folder, this file resides in the following path: 
C:/Program Files/Parallels/Parallels 
Tools/ParallelsToolsCenter.exe. 
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Clipboard Synchronization Tool Options 

 

Status: 

 Enabled shows the current status of the Clipboard Synchronization Tool. To temporarily 
disable this tool, deselect this check box. You can enable the Clipboard Synchronization 
Tool by selecting this check box later. 

Current clipboard content: 

 This field displays the current clipboard contents that can be scrolled.  
 The Clear button empties the clipboard contents.  

Description: 

 Displays the short description of the tool. For a complete description see the Parallels Tools 
Overview (page 49).  

Activating changes: 

After you have made the desired changes on the tab, do one of the following: 

 Click the Apply button to activate changes. 

Click the OK button to activate changes and hide the Parallels Tools Center. 
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Time Synchronization Tool Options 

 

Status: 

 Enabled check box shows the current status of the Time Synchronization Tool. To 
temporarily disable this tool, deselect this check box. You can enable the Time 
Synchronization Tool by selecting this check box later. 

Note: Before starting the Time Synchronization Tool, please stop all other time synchronization 
services in order to avoid potential conflicts. 

Advanced options: 

 Synchronization interval, sec. contains the period of time between two synchronization 
operations. Use scroll buttons in the field to set the desired value or simply enter it into the 
field. The interval value should be from 10 to 3600 seconds. 
To synchronize the guest OS system time with the primary OS: 

1. select this check box, 

2. set the desired value of the synchronization interval in the Synchronization Interval field. 
 Keep time difference between primary OS and guest OS check box allows you to maintain a 

constant difference between the guest OS system time and primary OS system time. 
To use this feature: 

1. select the Enabled check box, 

2. select the Keep Time Difference option, 

3. in the guest OS, set the desired current time.  
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The Time Synchronization Tool will calculate the lag/advance value at the moment when 
the guest OS time is set and will maintain it.  

Description: 

 Displays the short description of the tool. For a complete description see the Parallels Tools 
Overview (page 49).  

Activating changes: 

After you have made the desired changes on the tab, do the following: 

 Click the Apply button to activate changes. 

Click the OK button to activate changes and hide the Parallels Tools Center. 
 

Video Driver Options 

 

Status: 

 Enabled check box shows the tool's current status but is inaccessible for editing. 

Description: 

 Displays the short description of the tool. For a complete description see the Parallels Tools 
Overview (page 49).  
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Mouse Synchronization Tool Options 

 

Status: 

 Enabled check box shows the tool's current status but is inaccessible for editing. 

Description: 

 Displays the short description of the tool. For a complete description see the Parallels Tools 
Overview (page 49).  
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Network Driver Options 

 

Status: 

 Enabled check box shows the current status of the Parallels Network Adapter Driver. If this 
check box is selected, it means the Parallels Network Adapter Driver is active. We 
recommend that you use this driver whenever possible, however, you are able to temporarily 
return to the native Realtek RTL8029 driver at any time. 
To enable the Parallels Network Adapter Driver select the Enabled check box. To return to 
the native Realtek RTL8029 driver deselect the Enabled check box. Drivers can be changed 
without restarting the guest operating system, however your network connection may be 
temporarily lost. 

Description: 

 Displays the short description of the tool. For a complete description see the Parallels Tools 
Overview (page 49).  

Activating changes: 

After you have made the desired changes on the tab, do one of the following: 

 Click the Apply button to activate changes. 

Click the OK button to activate changes and hide the Parallels Tools Center. 
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Disk Compacting Tool Options 

 

Status: 

 The table displays the list of volumes located on the expanding virtual hard disks connected 
to your virtual machine and formatted to Windows file systems. Volumes formatted to other 
file systems are not displayed even though they may be physically located on the expanding 
virtual hard disks. In the table you can select the volumes to be processed by the Disk 
Compacting Tool. 

 Execute all stages at once. Select this check box if you want to perform both stages of the 
compacting process at once. See the description of the two stages of the compacting process 
in the Compacting Procedure of the Compacting Virtual Disk (page 140) topic.  

 Start button starts the process of preparing the virtual hard disks for compacting. 

Description: 

 Displays the short description of the tool. See the complete description and guidelines in the 
Compacting Virtual Disk (page 140) topic. 
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Shared Folders Options 
 

 

Status: 

 Enabled check box shows the tool's current status but is inaccessible for editing. 

Advanced Options: 

 Place shortcut on the desktop option controls the presence of the Parallels Tools Center 
shortcut on the guest OS desktop. 

Description: 

 Displays the short description of the tool. For a complete description see the Parallels Tools 
Overview (page 49).  
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Compacting Virtual Disk 

What Is the Disk Compacting Tool? 

Expanding virtual disks grow in size as you work with them. Besides applications and their 
data, every disk accumulates temporary files. The Disk Compacting Tool, included in Parallels 
Desktop, cleans up the unused disk space occupied by temporary files, thus reducing the size of 
expanding virtual hard disks. We recommend that you use Disk Compacting Tool from time to 
time to save space on the host hard disk.  

The Disk Compacting Tool processes the following partitions: 

 volumes located on the expanding virtual hard disks and formatted to Windows file systems 
(FAT 16, FAT 32, and NTFS).  

Note. The Disk Compacting Tool does NOT process: 1) volumes located on expanding virtual 
hard disks but formatted to file systems other than Windows, 2) plain virtual disks. 

Besides the Disk Compacting Tool, Parallels Desktop includes another tool for maintaining 
virtual hard disks: the powerful Parallels Compressor. Parallels Compressor not only reduces the 
disk size, but allows you to keep your disks effective in many other ways. For information on 
this tool refer to the Running Parallels Compressor (page 144) chapter. 

Compacting Procedure 

In general the compacting procedure consists of two stages that can be performed separately: 

1 A preparation step, performed in the guest OS, when an unused disk space is marked.    

This step can be performed only in those guest OSes where the Parallels Tools Center can 
be installed, i.e. in Windows 95/98/NT/ME/2000/XP/2003 guest OSes. See Installing 
Parallels Tools (page 48) for guidelines on installing the Parallels Tools package. 

2 A compacting step, performed in the primary OS, when the unused space is removed.  

This step can be performed in two ways:  

 Immediately after the preparation step is completed. 

All of the selected expanding virtual disks are compacted in one operation.  

This option is available in those guest OSes where the preparation step can be 
performed, i.e. in Windows 95/98/NT/ME/2000/XP/2003 guest OSes. 

 When the virtual machine is powered off.   

Compacting is launched for each expanding virtual disk one-by-one. 

This option is available in all guest OSes.  

How to Compact Expanding Virtual Disks 

To compact disks in Windows 95/98/NT/ME/2000/XP/2003 guest OSes: 

1 In the running virtual machine, open the Parallels Tools Center. See the Parallels Tools 
Center (page 132) topic to learn how to do so.  
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2 In the Parallels Tools Center, open the Disk Compacting Tool tab.  

3 In the Disk Compacting Tool Options (page 138) tab, a table in the Status group displays 
the list of volumes that can be compacted. Select the volumes you want.  

If you want to proceed to compacting immediately after the preparation step is completed, 
select the Execute all stages at once check box.  

Click the Start button to begin preparing disks.  

4 During the preparation step the Preparing for compacting. Please wait... message is 
displayed.  

5 If you have selected the Execute all stages at once check box: 

When the disks are ready for compacting, The Disk Compacting Tool pauses Virtual 
Machine execution and starts compacting. The Compacting virtual hard disk box is 
displayed.  

When the process is finished, you are informed that the "Process of compacting 
of virtual hard disk(s) has been successfully completed". Click 
OK to continue working with the virtual machine.  

6 If you have NOT selected the Execute all stages at once check box: 

When the disks are ready for compacting, you are informed that "You are able 
either start compacting right now or do it when the virtual 
machine is powered off".   

If you select to start compacting, the Disk Compacting Tool performs compacting as 
described in step 5.  

If you select to put compacting off, you may continue working with the virtual machine. See 
the subtopic below to learn how to start compacting later. 

To compact expanding virtual disks in any guest OS: 

 When the virtual machine is powered off, click the Compact button on the Advanced tab of 
the Hard Disk Options for each expanding-type virtual disk. While compacting is performed, 
the Compacting virtual hard disk box is displayed. When the process is finished, you are 
informed that the "Process of compacting of virtual hard disk(s) has 
been successfully completed".  

 

Setup a Printer in a Virtual Machine 
There are two principal methods of configuring printing in a virtual machine: 

 Setup a network printer. 
We recommend that you use this method since it provides the most stable work. 

 Setup a USB printer. 

Configuring a virtual machine for either method of printing is described below. 
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Setting Up a Network Printer 
Before installing a network printer in a guest OS make sure that your primary OS and the virtual 
machine meet the following requirements: 

 Networking in your primary operating system is configured. 
 Virtual machine configuration includes the network adapter which is connected to a real 

network adapter of your computer. See the Network Adapter Options (page 93) of your 
virtual machine; make sure that the Enabled and the Connect at startup options are selected 
in the Device Status group. In the Emulation group the Bridged Ethernet option should be 
selected and the real network interface should be chosen in the Network Adapters list. 

 Networking in the guest OS is configured. 
 User account from which you will setup the printer has permission to access the network 

printer. 

In a Linux or FreeBSD Guest Operating System 

Make sure that the following components are installed in your guest Linux or FreeBSD system: 

 Common UNIX Printing System (CUPS). Installation instructions can be found at CUPS 
site http://cups.org/documentation.php; 

 Samba service. Installation instructions can be found at  Samba site 
http://us4.samba.org/samba/docs/man/Samba-HOWTO-Collection/install.html; 

 A Web browser, since we consider controlling CUPS via web interface; 
 Also you have to know the root password. 

To add a network printer in a Linux or FreeBSD guest OS: 

1 Start your Linux or FreeBSD guest operating system. 

2 Start Common UNIX Printing System.  

In the Terminal, issue the command: 
/etc/init.d/cups start 

3 Start a Web browser and open either the IP address of your virtual machine or 
http://127.0.0.1:631. 

4 Select Printers in menu. Click the Add printer button below the list of available printers (if 
any).  

5 You are asked for the root password. Enter it to be able to proceed. 

6 In the Add New Printer screen enter the information for easy identification of the printer: an 
informative printer name, location, and description. 

7 In the Device for <Printer Name> screen select the Windows Printer via Samba. 

8 In the Device URI  for <Printer Name> screen specify the path to the network printer in the 
following format: 
smb://<computer name>/<printer name>

9 In the Model/Driver for <Printer Name> screen select the model of your printer. 

10 CUPS performs installation. If installation is successful, the "Printer <name> has 
been added successfully" message is displayed.  

 

http://cups.org/documentation.php
http://us4.samba.org/samba/docs/man/Samba-HOWTO-Collection/install.html
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In a Windows Guest Operating System 

To add a network printer in a Windows guest OS: 

 Start the Windows guest operating system and log in the proper account. 
 Open Windows Start menu, select Settings and then the Printers and Faxes (or simply 

Printers) item. 
 Open the Add Printer Wizard: 

In Windows 95/98/NT/ME/2000/2003 double-click the Add printer icon. 

In Windows XP click the Add a printer link. 
 In the Add Printer Wizard: 

In Windows 2000/XP/2003: 

- click Next in the wizard's first screen, 

- in the Local or Network Printer screen, click A network printer, or a printer attached to 
another computer. 
In Windows 98/ME: 

- click Next in the wizard's first screen, 

- the wizard's next screen asks: How is this printer attached to your computer? Click the 
Network printer option.  

In Windows 95/NT: 

- click Network printer/server. 
 Continue an ordinary network printer installation. 

 

Setting Up a USB Printer 
To setup a USB printer: 

1 Open the virtual machine configuration in the Configuration Editor (page 80), and make 
sure that the configuration includes a USB controller; if necessary add it.  

2 Open the USB Options (page 98), and make sure that the Enabled option is selected. Select 
the Autoconnect at startup if you want the printer to be automatically captured by the virtual 
machine. 

3 Save the virtual machine configuration (see Saving Virtual Machine Configuration (page 
81)) and start the guest operating system. 

4 Connect the USB printer as a normal USB device. See the Connecting USB Devices (page 
131) topic. 

5 Install the native driver for the printer in the guest OS. 
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Using Parallels Compressor 

Parallels Compressor is a new, easy-to-use Parallels tool which will help you keep your virtual 
machines efficient for many purposes.  

Parallels Compressor allows users to: 

 effectively clean up disk space in a virtual machine  
 significantly reduce the size of virtual hard disks 
 efficiently use the real hard disk resources 
 easily share smaller virtual disks by burning them to CD/DVDs or moving them over a 

network. 

In This Chapter 
How Does Parallels Compressor Process a Virtual Machine?.............................................. 145 
Requirements for the Guest Operating System..................................................................... 146 
How to Run Parallels Compressor ........................................................................................ 146 
Compression in Automatic Mode ......................................................................................... 149 
Parallels Compressor Wizard................................................................................................ 153 
Options of Parallels Compressor........................................................................................... 159 
Further Reducing the Disk .................................................................................................... 163 
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How Does Parallels Compressor 
Process a Virtual Machine? 

Compressor processes a virtual machine in the following way: 

 Deletes unneccessary files on the current system. 
 Defragments virtual disks of all formats and cleans up unused space. 
 Compacts expanding disks.  

The actions performed on your particular virtual machine depend upon the running mode: 
automatic or manual : 

 In automatic mode Parallels Compressor compresses only the current system disk 
performing the pre-defined set of actions. If this disk is plain, it will not be compacted. 

 In manual mode you are able to choose disks to compress and actions to perform.  

More about running modes and other Compressor properties can be found in the Options of 
Parallels Compressor (page 159) section. 

Steps of the Compression Procedure 

Parallels Compressor is designed to perform the most efficient compression of a virtual 
machine, including compacting of virtual disks that can significantly increase the ratio of useful 
data in your virtual machine. The procedure consists of two steps: 

 a preparatory step performed in the guest operating system (deleting of temporary and 
unnecessary files, cleaning up of unused disk space); and 

 a compacting step (reducing virtual disk size) performed in the primary operating system.  
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Requirements for the Guest 
Operating System 

To run Parallels Compressor your virtual machine should have one of the following guest 
operating systems installed: 

 Windows Server 2003 Standard Edition SP0, SP1 
 Windows Server 2003 Enterprise Edition SP0, SP1 
 Windows Server 2003 Web Edition SP0, SP1 
 Windows Server 2003 Small Business Edition SP0, SP1 
 Windows XP Professional Edition SP2 
 Windows XP Home Edition SP2 
 Windows 2000 Professional SP4 
 Windows 2000 Server SP4 
 Windows 2000 Advanced Server SP4 

In other guest operating systems we recommend using the Disk Compacting Tool (page 140). 
 

How to Run Parallels Compressor 

Before Starting Parallels Compressor 

Before starting Parallels Compressor perform the following steps: 

1 Back up your virtual machine by cloning it or by copying its hard disk files to a safe 
location. 

This enables you to restore your VM in case you do not like the results of the compression, 
as this operation is irreversible. 

Note. The result of virtual machine compression is irreversible. Before starting Parallels 
Compressor please back up your virtual machine. 

2 Make sure your virtual machine configuration includes the CD/DVD-ROM drive. 

If it does not: 

 power off the virtual machine, 

 open the Configuration Editor (page 80), 

 add a CD/DVD-ROM drive into the configuration if it is not included. Refer to Adding 
New Devices to Virtual Machine (page 99) for details, 

 on the CD/DVD-ROM Options (page 91) tab make sure that the Enabled check box is 
selected. 
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How to Start Parallels Compressor 

To start Parallels Compressor: 

1 Power on the virtual machine you want to compress. 

2 Log in to the guest operating system as a user with administrator rights. 

Note. To run Parallels Compressor in a virtual machine you must have administrator rights 
in the guest operating system.  

3 Select VM -> Start Parallels Compressor in the menu. 

Running Parallels Compressor 

Parallels Compressor has the following running modes: 

 automatic (page 159), the default mode. In this mode Compressor uses the default 
compression options. 

  manual (page 159), Parallels Compressor runs as a wizard which helps you select the 
options of virtual machine compression. 

When you start Parallels Compressor, the ISO file with Compressor is connected to the virtual 
CD/DVD-ROM and displays the dialog box with a time indicator. The time indicator shows the 
time remaining until Parallels Compressor will run in automatic mode (timeout is about 10 
seconds). 

 

To run Parallels Compressor: 

 in automatic mode, don't do anything, just wait until the timeout expires. Detailed 
information about running Compressor in this mode is given in the Compression in 
Automatic Mode (page 149) topic. 

 in  manual mode, press the ESC key or click the Manual Mode button on the dialog box 
before the timeout expires. Detailed information about running Compressor in this mode is 
given in the Parallels Compressor Wizard (page 153) topic. 
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After Compressing Is Finished 

When Parallels Compressor finishes its work, it disconnects the ISO with Parallels Compressor 
from the virtual machine and restores the previously existed connection. If the connection is not 
restored automatically: 

 select VM / Cancel Parallels Compressor in the menu. 

Note. Do not perform this command when Parallels Compressor is running. If the ISO file is 
disconnected during the process, the virtual machine may behave unpredictably. 

Also refer to Further Reducing Disk Size (page 163) to get an idea of what else you can do to 
compress virtual hard disks. 
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Compression in Automatic Mode 
In automatic mode Parallels Compressor uses the following default options: 

 only one virtual system disk is being processed (if the virtual machine has several system 
disks, the one which the VM was booted from is compressed);  

 compression is performed at the High level (page 162), and all compression tasks will be 
executed, except for Clean up Drivers Cache, which will be skipped. 

Note. During its work, Parallels Compressor displays several dialog boxes. Although they are 
used for information purposes, you can click Cancel any time to stop Parallels Compressor or 
click the Help button to get necessary information. 

1  Parallels Compressor displays the Execution in progress dialog box that informs what tasks 
are being executed. 
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2 The next screen states that Parallels Compressor is going to restart the virtual machine.  

 
3 Parallels Compressor restarts the virtual machine.  

4 After restart, it displays the dialog box with the time indicator which shows the time 
remaining until Parallels Compressor will continue the execution of compression tasks.  

 

 



 Using Parallels Compressor 151 
 

If you click the Manual mode button before the timeout expires, you can postpone the 
execution of the remaining tasks. In this case you will see the dialog box below.  Click Next 
at any time to let Parallels Compressor continue the compression. 

 
5 When Parallels Compressor resumes the execution of compression tasks (after restart of the 

virtual machine), it informs of the tasks currently being performed on the Execution in 
progress dialog box. 
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6 When Parallels Compressor successfully finishes its work, you will see the following 
screen.  

 
Click Finish to exit Parallels Compressor. 
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Parallels Compressor Wizard 
In manual mode, Parallels Compressor starts as a wizard. 

1 The wizard displays the Welcome screen.  

 
If you'd like to skip the Welcome screen next time you run the wizard, select the Skip 
introduction next time check box. Click Next to continue. 
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2 Choose mode of virtual machine compression. At this step, the wizard detects the type of 
virtual machine and the guest operating system installed. The wizard prompts you to choose 
between Express compression and Advanced compression (page 160). 

 
If you choose Express compression, the wizard will use the default options specific for the 
type of virtual machine and guest operating system.  

If you choose Advanced compression, you will be able to select certain options of 
compression.   
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3 Select Logical Disk(s). The wizard determines what hard disks are available in your virtual 
machine. Please read the Selecting Logical Disks for Compression (page 161)  topic if you 
are not sure what disk formats are supported.  

Use check boxes to select disk or disks. 

 
Click Next. If you selected Express compression (page 160) in the Step 3 then go straight to 
Step 6.   
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4 Choose Compression Level.   

 
The wizard prompts you to choose the Compression level (page 162). There are three levels: 
High, Medium, Low. 

To choose the level, place the cursor over the level slider and smoothly move slider to the 
desired level or just click the levels consecutively starting from High until the slider reaches 
the desired level. 

Each level suggests that certain tasks (page 162) be executed. Additionally, you can select 
check boxes for tasks you want to be executed and clear the check boxes for tasks you don't 
want to be executed. You also can click the Select all button to select all tasks or click Clear 
all to clear all check boxes. Click Set as default to restore the selection of tasks that are 
default for the chosen level. 

The check box for the Compact virtual disk task is always disabled.  

Click the Compress button. The wizard starts executing the selected tasks, and you can see 
the progress of the operation. 

If you cleared the check box for the Truncate page file option, the wizard skips Step 5 and 
Step 6. 
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5 Preparing to restart. Depending on the tasks you have selected on the previous step, the 
wizard may require restarting the computer . 

 
Click Next to restart your virtual machine. 

If you click Cancel  the process of virtual  machine compressing will be resumed 
automatically the next time you start your virtual machine. 
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6 After the restart is complete, the wizard is ready to resume the execution of tasks. Click 
Next. 

 
7 On the wizard's next dialog box, you can see the progress of operations. If you have chosen 

Express compression, the wizard performs the disk compacting without prompting you to 
confirm this operation. 

8 Disks compacting is the final step of compression.  

 
Click Yes to perform the operation. Click No to skip disk compacting. 

The compacting of a selected virtual disk will not be performed if a selected disk is in plain 
format or not a system disk. For more information please refer to the Selecting Logical 
Disks for Compression (page 161) topic. 
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9 Compression of the virtual machine is completed. 

 

Now, your virtual machine is compressed and its expanding disks are significantly reduced in 
size. 
 

Options of Parallels Compressor 
This Section describes in detail all the options of Parallels Compressor available in manual 
mode. 
 

Running Modes 
Parallel Compressor has two running modes:  

 Automatic. Default running mode. In automatic mode,  Parallels Compressor performs 
Express Compression (page 160) without prompting the user to confirm operations. 

 Manual. Parallels Compressor runs as a wizard (page 153) which helps you choose various 
compression options. 

Once launched, Parallels Compressor displays the dialog box with a time indicator showing the 
time remaining until Parallels Compressor will run in automatic mode.  

To run Parallels Compressor in automatic mode don't do anything, just wait. 

To run Parallels Compressor in  manual mode press the ESC key or click the Manual mode 
button before the timeout expires.  
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Command-line keys for Parallels Compressor 

The current version of Parallels Compressor has the following keys: 

 /A - to start program in automatic running mode; 
 /Q - to disable messaging ("quiet mode"); 
 /G <cmdline> - to start third party defragmentation tool instead of the tool used by Parallels 

Compressor, <cmdline> stands for the path and name of such tool; 

/H - to open help panel with the list of available keys. 

Comments to command line format 

 The program name and key are separated by a space.  
 If spaces are used in the <activation key> or in <cmdline>, enclose the expression in double 

quotes as follows: 
ParallelsCompressor /G"C:\Program Files\...defrag.exe" 

 There is no space between the key and its parameter as in the example above. 
 

Express and Advanced Modes 
When launched in manual mode, Parallels Compressor offers to choose the compression mode 
in which the virtual machine will be processed:  

 Express compression. Recommended for all users. By default, in this mode, the 
compression is performed at the high level (page 162). That means, all compression tasks 
(page 162) will be executed except for Clean up Drivers Cache (which is skipped by default). 
During Express compression, only one virtual disk is processed, the current system disk. 

 Advanced compression. Recommended for advanced users only. In Advanced compression 
mode, the wizard lets the user select options: logical disks, desired compression level (page 
162), and which tasks to execute. 
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Selecting Logical Disks for Compression 
A virtual machine may have several virtual disks. In manual (page 159) mode you can select 
one or more logical disks for compression.  

In the Select Logical Disks dialog box, Parallels Compressor displays the list of virtual machine's 
disks in expanding and plain formats. 

Please take into account the limitations discussed below. 

Virtual machine compression is performed in two steps: 

 disk cleaning: removing unnecessary files, disk defragmenting 
 disk compacting: reducing the size of a virtual disk file performed in host operating system 

Expanding disks  

Both steps can be performed only on a virtual disk in expanding format.  

Plain disks 

Parallels Compressor performs only a disk cleanup step on selected plain disks, system or not; 
disk compacting can not be done for plain disks. 
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Compression Levels 
Parallels Compressor supports three levels of compression: Low, Medium, High. Each 
level suggests the execution of certain tasks. The wizard displays the complete list of such tasks.  

The complete list includes the following tasks: 

 Truncate Page file (recreates the system page file of smaller size); 
 Clean Up Temporary System Files (deletes temporary files used by the system for 

acceleration of operations); 
 Clean Up System Cache (temporary data stored by system on disk to increase 

performance); 
 Empty Recycle Bin (permanently removes previously deleted files from the Recycle Bin); 
 Clean Up Temporary Internet Files (cleans up the Internet Explorer cache, deletes 

cookies, history, address bar, temporary files); 
 Disable Hibernate file (disables hibernate file which stores the virtual machine memory 

when the virtual machine is turned off); 
 Compact virtual disk(s) (reduces the size of disk in host (primary) operating system); 
 Clean Up Temporary Setup Files (deletes installation files used by MS Office and other 

programs);  
 Clean Up System Media Files (deletes temporary files used by Media Player); 
 Clean up Drivers Cache (empties the cache for the most popular drivers. If you are going 

to install new hardware, clear this check box); 
 Clean Up System Restore Information (deletes data related to the last successful system 

loading). 

By default, tasks are assigned to the compression level in the following way: 

 High level: all tasks on the list (those marked by , , )  
 Medium level: all tasks marked by  and  
 Low level: only tasks marked by  

The desired level of compression can be chosen with the help of a slider which has three 
positions: Low,  Medium, High. For each task on the list there is a check box. When the slider 
is at the High position all tasks are selected. Moving the slider from the High to Medium 
position, clears check boxes for tasks marked by ; moving the slider to the Low position 
clears check boxes for tasks marked by  and leaves selected only those tasks which are 
suggested for execution at the Low level ( ).  

Additionally, with any level chosen, you can add/remove tasks by selecting or clearing 
corresponding check boxes. To restore the selection of tasks default for the chosen level,  click 
the Set as default button. 

Note. The check box for the task: Compact virtual disk(s) - cannot be cleared; this task is 
mandatory for each level. 

In Express compression (page 160) mode (or in automatic mode) all tasks are executed as 
suggested by the High level, only the Clean up Drivers Cache task is skipped. 
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Advanced compression (page 160) allows users to select any set of tasks. 
 

Further Reducing the Disk 
After you have run Parallels Compressor you can further reduce the disk size. 

If you are going to share the virtual machine files with other users, then the smaller its disks are, 
the better. Once Parallels Compressor has completed its work, turn off the virtual machine. 
Running the virtual machine after compression has been completed will increase its system disk 
file (the system page file increases as the virtual machine is running). As the virtual hard disk is 
just a file on your computer, you can archive it with WinZip or WinRAR, whatever you prefer. 
The size can be reduced by 50% or more. 
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Using Parallels Image Tool 

This chapter provides all the information necessary to use Parallels Image tool. Since a virtual 
machine operates virtual hard disks which are image files and uses virtual CD/DVDs which are 
images of real discs, the Parallels Desktop package includes a special tool for creating and 
supporting images - the Parallels Image Tool, which is automatically installed along with 
Parallels Desktop. 

In This Chapter 
Overview............................................................................................................................... 164 
How to Start Image Tool....................................................................................................... 165 
Modifying Hard Disk Images................................................................................................ 165 
Creating Images of CD/DVD discs....................................................................................... 174 
 
 

Overview 
Parallels Image Tool allows you to: 

 modify existing images of virtual hard disks including conversion of images to other 
formats (see the Format of The Virtual Disk (page 76) in the Hard Disk Images topic), 

 create ISO images of real CDs or DVDs. 

The Image Tool can perform the following operations on hard disk images: 

 Increase the disk size of a hard disk image. 
Both expanding and plain disks can be enlarged. Note that disk size can not be reduced. 

 Convert a plain hard disk image to an image in expanding format. 
The result of the conversion can be saved in the same file as well as in another one. 

 Convert an expanding hard disk image to an image in a plain format. 
The result of the conversion can be saved in the same file as well as in another one. 

 Defragment an expanding hard disk image. 

Parallels Image Tool is designed as a wizard.  The wizard guides you through all the steps 
necessary to perform the required operation on the image.  Furthermore, the wizard keeps all 
your previously selected options between uses in case you often perform the same operation. 
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How to Start Image Tool 
To start the Parallels Image Tool: 

1 Click on the Finder. 
2 Select Applications.  

3 On the list of available applications find the Parallels folder, click to open it. 

4 Double-click the Image Tool icon. 
 

Modifying Hard Disk Images 

Warning. Before you start modifying an image of a virtual hard disk, please always back it 
up. 

Requirements for Source Disk 

The modifying operations require that the source hard disk image should not be in use by a 
running virtual machine. 

Checking Disk Format 

When selecting a disk image to modify, make sure that you select the source hard disk image of 
a proper format.  

To check the disk format do the following: 

1 Open the configuration of any virtual machine that includes this virtual hard disk. 

2 In the Configuration Editor open the Advanced (page 90) tab of the Hard Disk Options 

3 You will see the disk format in the Disk format field.  
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Using the Wizard to Modify an Existing Hard Disk Image 
1 Start the Parallels Image Tool (page 165). Upon startup, the wizard displays the Welcome 

screen. If you want to skip this screen next time you run the Image Tool, select the Skip 
Introduction next time check box. 

Click Next. 
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2 On the Choose device type screen select the Hard Disk option and click Next.  
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3 On the Hard Disk wizard's screen choose the operation you want to perform on the virtual 
hard disk.  

There are four available operations for virtual disks images: 

 Increase size of hard disk image to make a hard disk image larger, 

 Convert plain hard disk image into expanding hard disk image or create an expanding 
copy of a plain hard disk image, 

 Convert expanding hard disk image into plain hard disk image or create a plain copy of an 
expanding hard disk image, 

 Defragment expanding hard disk image to optimize files arrangement on a virtual disk 
and to increase disk operation speed. 

Choose the operation, then click Next.  
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4 Next, you have to specify the options for the selected operation. 

On the Increase Size of Virtual Hard Disk screen select the source hard disk image and the 
new size for the disk. Use the Browse button to locate a file. Use the spinner buttons next to 
the New Size field to set the required value. 

Note. Parallels Image Tool doesn't allow you to decrease the image size.  
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On the Convert Plain Disk to Expanding Disk screen select a source plain disk image using 
the Browse button. Once the source file is selected, the same name appears in the Output 
Image File field. If you want to save the result of the conversion into a different existing or a 
new file, use the Browse button to the left of the field. 
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On the Convert Expanding Disk to Plain Disk screen select a source expanding disk image 
using the Browse button. Once the source file is selected, the same name appears in the 
Output Image File field. If you want to save the result of the conversion into a different 
existing or a new file, use the Browse button to the left of the field. 
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On the Defragment Virtual Hard Disk screen specify the name of a source hard disk image. 
Use the Browse button to locate the required file.  

 
Click Next. 

5 The wizard will display the chosen operation and selected options on the Review Processing 
Options screen. 

Carefully review the settings (operation, source image file, and destination file if present, 
etc.). If everything is correct, click the Start button to start the desired operation.  
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6 While the operation is being performed, the Execution in progress screen is displayed. After 
the disk image is created, the Execution completed screen appears. Close the Wizard by 
clicking the Exit button. 

 

The new disk image is ready and you can connect it to a virtual machine in the Configuration 
Editor. See Adding New Devices to Virtual Machines (page 99) to learn how to connect to a 
new hard disk image to a virtual machine, or the Hard Disk Options (page 88) to learn how to 
replace one of the currently connected hard disks with the new one. 

Also see the Hard Disk Images (page 75) section for ideas on using hard disk images in 
Parallels Desktop. 
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Creating Images of CD/DVD discs 
To create an image of a CD/DVD disc follow these steps: 

1 Insert the required disc into the CD/DVD-ROM drive of your computer. 

2 Start the Parallels Image Tool (page 165). Upon startup, the wizard displays the Welcome 
screen. If you want to skip this screen next time you run the Image Tool, select the Skip 
Introduction next time check box. Click Next. 
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3 On the Choose device type screen select the CD/DVD-ROM option and click Next.  

 
4 The Select Operation Type screen appears with the single operation Create new ISO image of 

CD/DVD already selected. Click Next. 
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5 On the Create New ISO Image of CD/DVD Disk screen select the source device (CD/DVD-
ROM on your Mac), and specify a destination folder and a name of the CD/DVD image file. 
Use the Browse button to select an existing file or specify a new file. Click Next.  

 
6 The wizard will display the chosen operation and the selected options on the Review 

Processing Options screen. 

Carefully review the settings (operation, source device, and destination file). If everything is 
correct, click the Start button to begin the operation.  

7 While the operation is being performed, the Execution in progress screen is displayed. Wait 
until the operation is completed.  
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8 After the disc image is created, the Execution completed screen appears. 

 
Click the Restart Wizard button to continue if you’d like to process more objects or perform 
other operations. Click the Exit button to close the wizard. 

The disc image is created and placed in the destination folder specified in step 5 and can be 
connected to a virtual machine CD/DVD-ROM drive. See the CD/DVD-ROM Options (page 
91) section to learn how to connect an .iso image to CD/DVD-ROM drive of a virtual 
machine. 

Also see the CD/DVD-ROM Real Disks and Images (page 77) section for ideas of using CD 
and DVD disc images in Parallels Desktop. 
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Reporting a Problem to the Parallels 
Team 

In order to enhance the quality of Parallels Desktop product, you are able to send feedback to 
Parallels Software International Inc. in the form of problem reports. In the case of a fatal error 
inside a Virtual Machine, Parallels Desktop automatically opens the Report a Problem window 
proposing user to send a report. You may also decide to send a report on your own if you should 
ever encounter incorrect system behavior. 

Automatically Generated Reports 

Fatal errors in a virtual machine lead to the automatic generation of a virtual machine status 
report which takes a console screenshot and opens the Report a Problem window for a user to 
decide whether he/she wants to send the report to Parallels Software corporation. The Report a 
Problem window contains the following elements. 
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The Technical data field shows the name of the .txt status report file that has been generated 
in accordance with the error. The status report holds information on the product version, your 
activation data, primary and guest OSes information, processor status, and so on. You can 
update the data if necessary. Click View to open the report in the text editor.  

The Session screenshot field holds the name of the .jpg console screenshot that has been 
made in accordance with the error. To see the screenshot click the View button. 

You may add a verbal description of the situation in the Problem description box. The text you 
enter here is saved in the status report in a separate block when you close the Report a Problem 
window by clicking OK button. 

To send the report to the Parallels corporation: 

1 Click the OK button in the Report a Problem window. 

2 Launch your e-mail client application, create a new letter and attach the status report and the 
console screenshot to it. They are located in the following directory: 

/Library/Parallels/bugreports/ 

The format of status report’s names and screenshots are the following: 
parallels-yyyy.mm.dd-hh.mm.ss.<txt/png>

3 Enter the following e-mail address for the recipient: 
reports@parallels.com

Creating a Report Manually 

To create a problem report, select Report a Problem in the Help menu. A report is generated 
which contains technical data collected at the moment that the Report a problem command was 
activated.  If a guest OS is running, a console screenshot is made.  

To send a report, perform the same actions as you would for an automatically generated report. 
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